AutoCAD Civil 3D 2011

Best Practices

April 2010
## Contents

**Chapter 1**  
**Introduction**  

**Chapter 2**  
**Templates, Styles, and Drawings**  
- Optimizing Drawing Templates  
  - Using the Correct Templates  
  - Drawing Tips  
- Using Styles  
  - Sample Styles  
  - Style Comparison  
  - Copying Styles  
- Delete Layers from a Drawing or Template  
- Setting Default Styles for New Objects  
- Conceptual Visual Styles  
- Labeling External References  
  - Adding Xref Labels  
  - Xref Layer Control  
- Managing Large Data Sets  
  - Defining Large Data Sets  
  - Efficient Data Processing  
  - Data Tiling  
  - Optimizing System Values, Variables, and Commands  
    - AutoCAD System Variables
### Chapter 3  
**Survey Data**  
- Setting Up and Working with Survey Data  
- Adding Contour Data  
- Importing Survey XML Data  
- Importing Point Coordinates

### Chapter 4  
**Project Management**  
- Organizing Your Data  
- Data Storage: Vault or Not  
- Drawing and Object Relationships  
  - Level 1: Individual Design Objects  
  - Level 2: Base, Linework, and Engineering Drawings  
  - Level 3: Production Sheets  
  - Digging It: Three-Level Project Structure  
  - Sample Project Structure  
- Data Reference Types  
  - Autodesk Vault Overview  
  - Vault Project Structure  
  - Advantages of Autodesk Vault  
  - Limitations of Autodesk Vault  
  - Best Practices  
  - Sample Uses  
- Data Shortcuts Overview  
  - Advantages of Data Shortcuts  
  - Limitations of Data Shortcuts  
  - Best Practices  
  - Sample Uses  
- External References Overview  
  - Advantages of Xrefs  
  - Limitations of Xrefs  
  - Best Practices  
  - Sample Uses  
- User Access Controls  
- Project Folder Structure  
- Working Folder Location  
- Sharing and Transferring Files  
- Autodesk Vault Setup
<table>
<thead>
<tr>
<th>Chapter 5</th>
<th><strong>Surface Data</strong></th>
<th>79</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Working with Large Surfaces</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>Controlling Surface Data Resolution</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>Reducing the Displayed Surface Area</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Editing and Copying Surfaces</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Filling in Gaps Between Surfaces</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Using Xref Data in Surfaces</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Copying and Moving Surfaces</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Working with Surface Points</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Filtering Point Files</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Working with LandXML Files</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>Working with DEM Files</td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>Working with Contour Data</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Minimizing Flat Areas</td>
<td>88</td>
</tr>
<tr>
<td>Chapter 6</td>
<td><strong>Sites</strong></td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Site Characteristics</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Multiple Sites</td>
<td>91</td>
</tr>
<tr>
<td>Chapter 7</td>
<td><strong>Corridor Design</strong></td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Alignments</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Alignment Design Strategies</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Superelevation</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Assemblies</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Baseline Location</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Assembly Offsets</td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>Drawing Management</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Corridor Code Set Styles</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Corridor Regions</td>
<td>98</td>
</tr>
<tr>
<td></td>
<td>Large Corridor Models</td>
<td>99</td>
</tr>
<tr>
<td>Chapter 8</td>
<td><strong>Parcels</strong></td>
<td>101</td>
</tr>
</tbody>
</table>

Contents | v
Grading Group Surfaces .................................................. 146
Using Explode With Grading Objects .............................. 147
Using Feature Lines and Projection Grading Together ............ 147
Grading and Corridor Interaction ...................................... 156
Targeting Feature Lines .................................................. 156
Grading from a Corridor Feature Line ............................... 158
Grade to Grade Interaction .............................................. 161

Chapter 10 **Pipe Networks** .................................................. 167
How the Parts Catalog Works ............................................ 167
Parts Catalog Management Practices ................................. 169
Standardizing Pipes and Structures .................................... 170
Problematic Scenarios ...................................................... 170
  Local Catalogs and a New Part ........................................ 170
  Local Catalogs and a Modified Part .................................. 171
Part Catalogs on Different Networks ................................. 171
Drawing Shared Between Two Companies ......................... 171
Creating User-Defined Optional Properties ....................... 172
  Assign Optional Properties to a Part Size ......................... 172
Parts Lists ................................................................. 174
  Backup Part Catalog .................................................... 174
  Parts List Rules .......................................................... 174
  Pipe and Structure Rules .............................................. 174
  Renaming Part Size Name ............................................. 175
Pipe Network Design ..................................................... 175
Networks in Profile and Section Views ............................... 177
Managing Pipe Data ....................................................... 180
  Locating Pipe Network Parts ......................................... 180
  Pipe Networks that Traverse Multiple Surfaces .................. 180
  Renaming Pipe Network Parts ...................................... 181
Network Labeling Strategies ............................................ 182
  Spanning Pipes ........................................................... 182
  Labeling Pipe External References ................................. 183
Hydraflow Extensions ..................................................... 184
  Importing/Exporting Storm Sewers Data ......................... 184
  Switch Between Imperial and Metric Units ......................... 185
  Hydraulic Grade Line and Energy Grade Line ..................... 185
  US Survey Foot Units .................................................. 185
  Hydrograph Pond Tools ................................................ 185
  Hydrograph Time Intervals ......................................... 185
  Updating .STM Files .................................................... 186
  Convert Rainfall Data to Correct Units ............................ 186
  Collecting Rainfall Data at a Constant Rate ....................... 187
  Storm Sewers Default Parts Matching ............................ 190
Digging It: Display Flow Capacity with Manning Equation ...... 193
  Manning Equation ....................................................... 193
Introduction

The Best Practices guide provides an overview of best practices for implementing AutoCAD Civil 3D and using it efficiently in design operations.

Topics in this guide

- **Templates, Styles, and Drawings** (page 3): Manage templates, styles, and drawings so you can work most efficiently with AutoCAD Civil 3D software.

- **Survey Data** (page 37): Best practices for working with survey data including preparing to import survey data, importing data, creating surfaces from survey data, and importing point coordinates from a field book file.

- **Project Management** (page 49): Organize your drawings, design objects, and work procedures to support a project team.

- **Surface Data** (page 79): Surfaces are essential to most design tasks in AutoCAD Civil 3D, and because of their size, it is important to structure them for efficient processing.

- **Sites** (page 91): Use sites in AutoCAD Civil 3D to manage the dynamic interaction of design objects within a project.

- **Corridor Design** (page 93): Best practices for corridor design, including suggestions for the related alignment, assembly, profile, and section objects.

- **Parcels** (page 101): Best practices for parcel creation, editing, and annotation, particularly in the context of subdivision design.

- **Grading** (page 129): Understand the strengths and limitations of the grading tools.

- **Pipe Networks** (page 167): Best practices for working with pipe networks parts catalogs, as well as for creating, editing and labeling pipe networks.

In addition to what this guide contains, you will find best practices in the *AutoCAD Civil 3D User's Guide* and *Moving from Land Desktop to C3D*. 
Customer Information

Several parts of this guide include a “Digging It” section that describes best practices developed by AutoCAD Civil 3D users. Their personal comments and related information are provided to demonstrate how AutoCAD Civil 3D is used on real engineering projects.

Legal Notice

Certain information described in this Best Practices guide was provided by third party contributors and/or customers of Autodesk. Autodesk provides this information “as is,” without warranty of any kind, either express or implied.
Templates, Styles, and Drawings

Manage templates, styles, and drawings so you can work most efficiently with AutoCAD Civil 3D software.

Optimizing Drawing Templates

You can configure the drawing templates used to standardize your project drawings in several ways to support large data sets. In particular, you need a range of object and label styles for different project phases and drawing types.

The following templates, supplied with AutoCAD Civil 3D, include styles with minimal displayed elements:

- _AutoCAD Civil 3D (Imperial) NCS.dwt
- _AutoCAD Civil 3D (Metric) NCS.dwt

For example, see the surface styles “_No Display” and “Border Only,” and the profile view style “First View.” These are useful as is, and also used as a basis for developing minimal styles for other objects.

Using the Correct Templates

Make sure to use the correct template when designing your drawing. When you select Application Menu ➤ New to access the Select Template dialog box, a large number of templates are available. The template, acad.dwt, is a default AutoCAD drawing template. Rather than using this template (acad.dwt) to create your drawings, use customized AutoCAD Civil 3D templates.
Specify a template to use with the QNEW Command

When you start AutoCAD Civil 3D using the imperial profile, the default template for a new drawing is \_AutoCAD Civil 3D (Imperial) NCS.dwt. When you start AutoCAD Civil 3D using the metric profile, the default template for a new drawing is \_AutoCAD Civil 3D (Metric) NCS.dwt. The default template is applied when you start AutoCAD Civil 3D or create a new drawing (QNEW command). You can specify a different default template that better suits your needs.

To change the default template

1. Enter Options at the command line.
2. In the Options dialog box, on the Files tab, expand Template Settings.
3. Change the value for Default Template File Name for QNEW to the template that you want to use.

![Figure 1: Set the default template](image)

4 | Chapter 2  Templates, Styles, and Drawings
NCS Templates

If your company uses the National CAD Standard (NCS), then you need to use a template that is set up with NCS standards.

- For metric data sets, use the AutoCAD Civil 3D (Metric) NCS template.
- For imperial data sets, use the AutoCAD Civil 3D (Imperial) NCS template.

Use the Appropriate Country Kit

There are country kits that contain drawing requirements for specific regions. Many regions have styles that users can download to ensure that drawings that local users create in AutoCAD Civil 3D meet the local submittal requirements. If you reside in a country that has an available country kit, make sure you start your project using the template file from the kit. For example, the template from the country kit for use in the United Kingdom and Ireland is called _Autodesk Civil 3D <version> UK_IE_Bylayer.dwt.

Drawing Tips

The following sections describe good practices that will help avoid mistakes when getting started with drawings.

Prevent Scaling

If you are using a 3D drawing, insert your 3D survey drawing into this file. You must ensure that the units of measure are not accidentally scaled to another unit. For example, if your drawing uses imperial units, it may accidentally be scaled to metric. To prevent scaling, set the INSUNITS value to 0.

Use References to Reduce Drawing Size

Create a surface directly from the point file rather than importing the points as COGO points. This practice avoids the use of system memory to keep the point data labels up to date. Rather than starting a design in the same drawing as the surface, create a data shortcut to the surface. This practice will dramatically reduce the active drawing size.

Apply Meaningful Names to Objects

Adopt a naming convention that applies useful names to differentiate objects. Because multiple people in your company may work with your drawings, it is important to use consistent and meaningful names.
Use Minimal Object Styles

For most efficient processing, use styles that have very little or no displayed elements. Minimal display styles draw faster, and are especially relevant for large objects, such as surfaces, point groups, and corridors.

Minimal display styles are useful in conceptual designs, the early stages of a project, and whenever you want to suppress the display of a surface or other large object. They can also apply to other objects, subject to the nature of your drawings. Minimal styles for objects, such as surfaces and corridors, should be configured in both 2D and 3D display modes for efficient use.

When designing corridors, you can create more efficient subassemblies by ensuring that the shape style for each one is defined with no fill, or at least with a solid fill rather than hatch patterns. Figure 2 shows the Shape Style dialog box, where you can define a subassembly shape style.

![Shape Style - New Shape Style](image)

**Figure 2: Editing a subassembly shape style**

Turn Off Labels

As with object styles, you can design separate label styles for use at different project stages, and for different audiences. For example, an empty “No Label” style is useful, especially for alignments, profile views, and other objects with label sets. You can switch off all labels for an object by applying this style. You can turn off labels to reduce clutter and drawing time for some design phases.
To turn off all labels for a feature:

1. Right-click the feature node on the Toolspace Settings tab.
2. Click Edit Label Style Defaults.
3. In the Edit Label Style Defaults dialog box, set label visibility to false, as shown in figure 3.

Figure 3: Turning off label visibility for a feature

If you want to create a label design that has just the essential data and can be drawn quickly, simplify all text and graphic elements, including the use of rotation, borders, and plan readability. Another useful tactic is to leave a style in place, but temporarily edit the style with the Label Style Composer to turn off the label visibility, as shown in figure 4.

Figure 4: Turning off label visibility

Use of Layers to Manage Display

For faster processing, freeze or turn off the drawing layers that contain objects. By default, design objects and their labels are divided across multiple layers. For example, as shown in figure 5, alignments, profiles, and other road design objects are spread across many layers, all beginning with C-ROAD. If you
consolidate the road design objects on fewer layers, it is easier to turn them on or off.

Figure 5: C-ROAD layers

From The Ground Up

Jack Strongitharm, an Autodesk Civil 3D Application Engineer for the UK and Ireland, has contributed some good ideas to this section. See Jack’s blog for more tips and tricks at: http://fromthegroundup.typepad.com/from_the_ground_up/

Using Styles

Every object has default styles and settings that you should become familiar with, and learn to configure for best results in your projects. However, it is not practical to try and master these for all objects as you learn to design with AutoCAD Civil 3D. Instead, become familiar with the default styles for objects and labels in your template and over time modify them to suit your needs.

Create Styles for Project Stages

Create a default style for initial object creation, then others for different stages of the design process, for different users, for different types of analysis, and for final presentation purposes. For many objects, the default styles may be adequate and you will require minimal changes as your requirements evolve.
As with object styles, create different label styles for different stages and purposes in the project lifecycle. During the design phase, use simple, fast-drawing labels for most objects to display only the essential data that supports the design process.

Best practices for the use of styles involve making additional styles available for composite drawings, turning layers off in some contexts to hide labels, and perhaps having multiple label styles on different layers.

### Sample Styles

The *Sample_styles.dwg*, provided with AutoCAD Civil 3D, can be used to preview Standard AutoCAD Civil 3D styles and note the differences between them. This drawing demonstrates how styles can be managed and the various ways in which styles can be transferred to other drawings. Review *Sample_styles.dwg* and see which styles you might want to change at the outset.

*Sample_styles.dwg* is available in the *Civil Best Practices Guide* folder in the AutoCAD Civil 3D installation, for example, `C:\Program Files\Autodesk\AutoCAD Civil 3D 2011\Help\Civil Best Practices Guide`.

### Style Comparison

We will compare some basic styles with more complicated styles within a single drawing and also compare a drawing template (.dwt) with a sample drawing. This exercise will help illustrate how some of the basic styles compare to a drawing that has undergone style additions and revisions. When starting out with AutoCAD Civil 3D, focus on the layout and use of the Toolspace Settings and Prospector tabs as they are critical components for style creation, control, and identification.

#### Surface Style Comparison

Open the sample styles drawing: `C:\Program Files\Autodesk\AutoCAD Civil 3D 2011\Help\Civil Best Practices Guide\Sample_styles.dwg`. The surface styles are designed to display different components of a surface at different design stages. The surface style assigned to the drawing is called Existing Ground Contours. This is an example of a style that would be used during the design stage of a project.

In the Surface Style - Existing Ground Contours dialog box, the Border, Major Contour, and Minor Contour components are set to visible. These components
determine how the surface appears in the drawing. With these components enabled, the surface is displayed as shown in figure 6.

Figure 6: Elevations and slopes are not visible

The following exercise demonstrates how to change the Existing Ground Contours style so that it reflects the Final Grade style. Editing the contour style will demonstrate how to experiment with styles to suit your requirements.

**To change the Existing Ground Contour style**

1. On the Toolspace Settings tab, expand the Surface styles collection and double-click the Existing Ground Contours style.
2. On the Display tab, click the light bulb icons to turn off the Major Contour and Minor Contour components.
3. Click the light bulb icons to turn on the visibility for the Elevations and Slope Arrows components as shown in figure 7. Keep the Border contour set to Visible.
Now the drawing displays borders, elevation differences indicated by color, and slope direction arrows and appears as shown in figure 8. The contour lines are no longer visible. These changes now reflect the components that are enabled for the supplied Finish Grade surface style.

The Finish Grade style is set up to display the drawing for presentation purposes or for the latter stages of a project.

Before setting up your styles you should explore the existing styles to determine what would work best for you. Remember that seemingly small style property edits can have dramatic effects in your drawings.
NOTE Take a conservative approach when creating styles and make additional changes only as warranted.

Parcel Style Comparison

For parcel styles, you can assign colors to differentiate between various types of parcel components.

To explore parcel styles

1 In the Sample_styles.dwg, on the Toolspace Settings tab, in the Parcel collection, expand the Parcel Styles collection and right-click Residential. Click Edit.

2 In the Parcel Style - Residential style dialog box, on the Display tab, the color of the parcel segments is set to blue.
   Observe that the parcel area fill component is visible and note the hatch pattern that is set for the parcel area fill.

3 Look at how another parcel style is composed. Click Application Menu ➤ New. In the dialog box, select _AutoCAD Civil 3D (Imperial) NCS.dwt.

4 Observe how the style for Single-Family parcels is set up differently. Specifically, the assigned color is different and the parcel area fill is not visible. The hatch patterns for these parcel styles are also different. If you click on the hatch pattern, the Hatch Pattern dialog box is displayed, where you can change the assigned hatch pattern.

The different hatch patterns for each of these styles shows one example of how different variables and combinations are possible when creating new styles or modifying existing ones.

Style Suggestions

While learning to use AutoCAD Civil 3D styles, consider the following:

- Start out with as few styles as possible until you become more comfortable with the product.
- Track your new styles so that you can keep them straight until you can remember the visible indications for each one.
- Take time to explore the wide range of style components and options. You may discover useful aspects of the tools that are not readily apparent.
Only create new styles as you need them. Remember that styles should serve your designs, and are tools to help improve your drawings and facilitate the process. They should not make your job more difficult. Once you become accustomed to their use and how they are created, copied, and edited, the application of styles will greatly enhance your drawings and make your job easier.

Copying Styles

There are various ways to duplicate or copy styles between drawings and templates. This practice saves the time it would take to re-create styles.

Copy Style in Master View

You can use drag and drop to transfer styles from one open drawing or template to another.

To copy a style

1. Open the Sample_styles.dwg and another drawing. On the Toolspace Settings tab, select Master View.

2. Click and drag a style from one of the drawings and drop it on top of the other drawing name.
   In the example shown in figure 9, the Grading Standard style was selected from the Sample_styles.dwg, and dragged and dropped onto the Breaklines.dwg name.

3. If the targeted drawing contains a style with the same name, the Duplicate Item Name dialog box enables you to either overwrite, rename, or cancel (skip) copying the item. You can also apply your choice (Overwrite, Rename, or Skip) to all future name conflicts during this work session.
   If the copied style transfers successfully, it appears when you expand the drawing’s style collection. No dialog box or prompt is displayed.
Figure 9: Use drag and drop to transfer style

Delete Layers from a Drawing or Template

From any drawing, you can delete layers that contain objects. When you create a standard template file, it is a good practice to delete the layers that you do not intend to use.

To delete unwanted layers from a drawing or template file

1. At the command line, enter LayDel.

14 | Chapter 2  Templates, Styles, and Drawings
2 Select the drawing objects on the layers that you want to delete, or use the Name option to select the layers from the Delete Layers dialog box as shown in figure 10.

3 Press the Shift or Ctrl key to select multiple layers from the list.

![Delete Layers dialog box](image)

Figure 10: Select layers to delete

**NOTE** When deleting layers from a template (DWT) file, verify that required/active styles or settings do not reference the layers.

### Setting Default Styles for New Objects

If you create a new style and want to use it as a default, you can change the command settings to use this style as the default when creating new objects. You should also adhere to this practice when creating label styles. There are several ways to do this.

**To set a style as the default style**

1. On the Toolspace Settings tab, right-click the drawing name. Click Edit Drawing Settings.

2. Click the Ambient Settings tab, and expand the General property. Set the Save Command Changes To Settings property to Yes as shown in figure 11.
Figure 11: Use command settings to set default styles

OR

1 On the Toolspace Settings tab, right-click any object collection. Click Edit Feature Settings.

2 Click the Ambient Settings tab, and expand the General property. Set the Save Command Changes To Settings property to Yes.

OR

1 On the Toolspace Settings tab, right-click a specific command item in an objects Commands collection. Click Edit Command Settings.

2 Click the Ambient Settings tab, and expand the General property. Set the Save Command Changes To Settings property to Yes.

Conceptual Visual Styles

For conceptual drawings/landscape plans, you can adjust the visual style to resemble a rough sketch.

To adjust the visual styles

1 Select Home tab ➤ Palettes panel ➤ Tool Palettes window.

2 Select Properties ➤ Visual Styles.

3 In the Visual Style Manager, right-click Sketchy Visual Style ➤ Properties.

4 In the Tool Properties Edge Modifiers section, click the icons to toggle on the Line Extensions Edges and Jitter Edges options.
   Line Extensions Edges controls the amount of overhang (line extensions) and Jitter controls the number of lines that are drawn.
Experiment with these values until the style is displayed as required.

This render style is scale dependent, so you may have to set an appropriate zoom level before you start the adjustment.

**NOTE** These styles are similar to the NAPKIN command options that create sketch effects, but these adjustments do not add additional entities to the drawing, they just display the styles differently.

**Transparent Surface Style**

Another possible use of visual styles is to display a surface as transparent. You can create a new visual style and set the global Opacity to a small number, or you can assign different kinds of glass render materials to the different surfaces and then render the drawing.

**Label Styles**

This section describes best practices for working with label styles.

**Editing Label Styles**

The ability to edit labels within the drawing eliminates the need to locate the styles on the Settings tab. Select the Edit Label Style option for quick access to the label style editing tools.

**To use the Edit Label Style option**

1. Select a label, right-click and click Edit Label Style.

2. This opens the <Object> Label Style dialog box as shown in figure 12 from which you can perform multiple commands to either create a new style, copy the existing style or child style, or edit currently selected style.

**NOTE** The Label Style Composer is accessed when you select Edit Current Selection.
You can drag and drop styles between drawings using the Settings tab Master View. You should not copy labels themselves from drawing to drawing.

If you drag a label style into the current drawing along with a label that refers to that label style and you overwrite it, you will lose the style.

**NOTE** You can use a crossing selection to change multiple labels. Draw a crossing selection window over labels that you want to edit, and then select Label Properties. Then use the Properties palette to edit the properties of the selected labels.

**Label Appearance**

In your final production drawings use as few labels as possible for best performance.

**Displaying Surface Elevation Cut/Fill Labels with Colors**

You can create label styles for different AutoCAD Civil 3D features. The use of expressions to calculate data can greatly enhance your annotation. An example of this is the use of an expression to create a label style that uses color to distinguish between surface cut and fill volume labels. In this example, the cut volume labels are red, and the fill volume labels are green.

**To display cut/fill labels with distinguishing colors**

1. Create a volume surface from the two surfaces you are comparing.

2. Create an expression for Surface Spot Elevation labels. Name it “Negative Value.” Use this expression: \(-1 \times \text{Surface Elevation}\).

   This expression takes a value, and multiplies it by negative one, changing a positive integer into a negative, or for this example, taking a negative and turning it into a positive.
3 Create a Surface Spot Elevation label style named “Cut Fill.” In the Label Style Composer dialog box, on the Layout tab, change the Name property of the label component to “fill.” Change its color to Green. Edit the text component and change the Sign Modifier to Hide Negative Value.

4 Make a new component for the Cut value by copying the Fill text component and renaming it to Cut. Change the color to red. Edit the text component, and replace with the Negative Value expression. Change the Sign Modifier to Hide Negative Value.

5 Use the Spot Elevations On Grid command to add labels to the volume surface, using the Cut Fill style. All the spot elevations in a cut area (where the volume surface is negative) will be labeled with the red label, and all the spot elevations with a fill area (where the volume surface is positive) will be labeled with the green label. Since the negative values are hidden, and the expression is used to convert a negative into a positive (the cut), the labels automatically display the appropriate spot elevation.

Labeling High and Low Points for a Profile View Curve

Experiment with label styles to display critical information in your drawings. A good practice with profiles is to label high and low points on a profile view curve.

To label high and low points on a profile view curve

1 In Toolspace, click the Settings tab.
2 Expand Profile ➤ Label Styles ➤ Curve.
3 Right-click the Curve collection and click New to create a new label style with the name Low Point.
4 Right-click Low Point and click Edit.
5 Click the Layout tab.
6 Create a new component for text by clicking Create Text Component.
7 Click on the value column for Contents and open the Text Component Editor dialog box.
8 In the Properties drop-down list, select Low Point Elevation. Click the arrow icon to add it to the label.
9  In the Text Component Editor, click at the beginning of the Low Point Elevation text properties. Press ENTER. In the Properties drop-down list, select Low Point Station. Click the arrow icon to add it to the label. The properties appear as follows: <[Low Point Station(Uft|FS|P2|RN|AP|Sn|TP|B2|EN|W0|OF)]><[Low Point Elevation(Uft|P3|RN|AP|Sn|OF)]>. Click OK to close the Text Component Editor.

10  Click the General tab and set the visibility to True.

11  Click OK to close the Label Style Composer dialog box.

12  Click a curve in a Profile View and right-click.

13  Click Edit Labels to display the Profile Labels dialog box.

14  Locate Sag Curves in Type and set Profile Sag Curve Label Style to Low Point.

15  Repeat steps 4 to 14 to create a High Point label style and assign it to a crest curve.

Labeling External References

In AutoCAD Civil 3D, you can label xref data. Xrefs enable you to input data for maximum flexibility in a new environment. This section describes how to label xrefs.

Adding Xref Labels

When working with xref data, you should store the source drawing with no labels. Add the labels after you have inserted the xrefs into your current drawing. If you decide to include labels in the source drawing, they should reside on a layer that can be turned off. Xref labels from the source drawing cannot be edited. After inserting xrefs, use the labeling commands as you would for other objects.

Parcel Xrefs

The recommendation to add labels after inserting xrefs into your current drawing applies when working with parcel xrefs. Use the source drawing as a canvas for your object data and avoid the clutter of annotation. For more information about labeling parcel xrefs, see Labeling Parcel External References (Xrefs) (page 122) in the Parcels chapter.
NOTE All xrefs transfer layers into the new drawing whether they are used or not. Components always reference layers, and all layers are transferred into the new drawing.

Xref Layer Control

You can use AutoCAD commands to control the display of Xrefs. For example, you can change the color, visibility, linetype, and other properties of xref layers with the AutoCAD VISRETAIN system variable. The layer settings affected are On, Off, Freeze, Thaw, Color, Ltype, LWeight, and PStyle.

Turn Off Layer Visibility

You can turn off label visibility as long as you know what layer the labels reside on. If you xref a parcel that includes a label, you should place the area label on a layer that will not plot or on a layer that you can freeze. You can set different layer references for the area label and the parcel segments. So after you insert the xref, you can freeze the area label layer and the parcel segments will remain visible. Then if you freeze the parcel segment layer, the entire parcel will disappear. When adding labels in the current drawing to objects referenced from an xref, the labels are placed on a layer in the current drawing based on the style definition.

Save Current Layer Settings

To save your changes to layer settings, enter VISRETAIN at the command line, and set the variable to 1. This saves the current session’s changes in the current drawing’s layer table so that in subsequent sessions, the layer state remains set to what you want. If VISRETAIN is set to 0 (zero), the settings are not saved after you close and the drawing.

Change Color ByLayer or ByStyle

There are two methods used to change color: using object by layer and object by style. When working with xrefs, it is important to remember the following:

■ Xref drawings are read-only, so the only thing that you can change are the layer states.

■ You cannot change the xref object style or label style.

■ You can change properties of layers.

■ You can use the xref edit command to make edits to the source drawing.
Subsequent changes to the source drawing dynamically change the xref data.

To change the color of an object, you can change the xref’s layer as long as you know what it is. Some users prefer to control ByLayer, while others prefer to use color explicitly to display an object no matter what layer it resides on. Use the method that works best for you.

Managing Large Data Sets

Any large project requires good planning to prevent—or at least minimize—unpleasant surprises. An AutoCAD Civil 3D project with large data sets is no different. In this case, the project team should set up its data files and configure AutoCAD Civil 3D for optimum efficiency of operations. Generating screen displays and propagating updates through a network of related objects can be very time consuming with large data sets, but there are many ways to reduce the processing time.

Defining Large Data Sets

For the purpose of this discussion, a large project includes one or more of the following data sets:

- A surface with more than a million points
- A subdivision with more than 200 lots
- A corridor longer than 15 km (9.3 miles)

If your projects use smaller data sets, you can still benefit from the advice in this document to improve your work processes and your computer system performance. Implementing some of these recommendations will also enable your team to take on larger projects if the opportunity arises.

Efficient Data Processing

This section describes best practices to retain optimum data processing efficiency as you build up the content of an AutoCAD Civil 3D model.
The tips and guidelines presented in this section are based on the following general principles:

- Groom the data so it can be processed faster. For input data such as points and surfaces, groom the data at the time of input, or before you start using it in the design process.
- Use data references to distribute the engineering model across multiple drawings, and to separate the production drawings from the engineering model.
- Minimize the display and update of objects not required in current design tasks.
- Close the Toolspace window when it is not necessary to have it open. Closing the Toolspace window can help improve overall performance as well as save memory. Likewise, it is recommended to close the Toolspace tabs (Prospector, Settings, Survey, or Toolbox) which you do not need to have open.
- Reduce the frequency of automated operations such as surface rebuild, drawing save, and virus scanning, or turn off these operations.

These principles are applied at several levels of an engineering project, including the drawing settings, object styles, project management, and working with objects. Because some of the best practices involve decisions to make at the beginning of a project, it is important to read this entire section and consider how to apply the recommendations to your projects.

**Data Tiling**

Tiling refers to segregating a model into manageable work zones. This process facilitates working with large amounts of data, and enables better data collaboration of the design team.

**Existing Ground Surfaces**

The existing ground surface model of a large corridor region can be created in tiles, with one tile per drawing. The combination of tiles represents the entire project. If adjacent surface regions must be used together for plotting or analysis, use data references to bring them in. For alignment design, combine the existing ground (EG) profiles from each of the surface tiles in a single profile view to display a continuous view of the EG profile.
**Large Subdivisions**

The concept of tiling a model is effective in dealing with large subdivisions. The lots and corridor models can be tiled so that designers can work simultaneously on multiple tiles, or phases of the project.

**Multiple Regions for Corridors**

With long corridors or corridor networks, create multiple regions for modeling purposes. Normally, corridor regions are used to mark the use of different assemblies, with a region boundary occurring where the use of one assembly ends and another begins. But you can also add regions without changing assemblies. The value of additional regions is control—you can use the Corridor Properties dialog box to turn off the modeling of regions not required for current operations, as shown in figure 13. This improves the speed of corridor rebuilding.

![Corridor Properties dialog box](image)

*Figure 13: Turning off corridor regions and baselines*

If your corridor includes some regions with few changes in the surface or the assembly, consider reducing the frequency of the corridor modeling in these regions to improve processing speed.

**Optimizing System Values, Variables, and Commands**

For better handling of large, detailed drawings, you can improve the performance of AutoCAD Civil 3D by configuring the settings for several system values, AutoCAD variables, and commands.
AutoCAD System Variables

Among over 500 system variables to control AutoCAD behavior, there are several that you can use to improve the handling of large data sets. This section explains first how to access the system variable editor, then provides background information and recommended settings for particular variables.

Accessing the System Variable Editor

To access the AutoCAD system variable settings, enter SYSVDLG at the command line or in the Civil 3D workspace, click Express tab ➤ Tools panel ➤ System Variable Editor. The following dialog box is displayed as shown in figure 14, providing a convenient interface for reviewing system variable descriptions and changing their settings.

![System Variables Dialog Box](image)

Figure 14: Setting system variables

If you have a large work group, you can create a script to run on each computer and standardize the AutoCAD settings. To do this, configure the variables on one computer, then click Save All in the System Variables dialog box. The settings are saved in an SVF file or an SCR file, each of which can be run on another computer to update settings. For more information, click Help on the System Variables dialog box.

3D Display Configuration

The display of a complex surface in 3D is memory intensive, especially if the surface includes graphic detail such as material rendering or a draped image.
You can improve performance of 3D display at the expense of graphic detail, a trade-off that may be acceptable during the design process. In the final project phase, you can revise these settings to get more detailed images for presentation purposes.

The main settings for 3D display are accessible when you enter the AutoCAD command 3DCONFIG. Doing this displays the Adaptive Degradation and Performance Tuning dialog box, as shown in figure 15.

![Adaptive Degradation and Performance Tuning dialog box](image)

**Figure 15: Adaptive degradation settings**

The adaptive degradation settings shown in figure 15 indicate that if the display speed drops below five frames per second, the system starts to degrade the display quality of fast silhouettes, view-dependent objects, and other items selected in the Degradation Order list. Depending on the data you are displaying and the graphics card in your computer, you may get better performance by turning off adaptive degradation.

**Manual Performance Tuning**

Another useful setting in the Adaptive Degradation and Performance Tuning dialog box is accessible when you click the Manual Tune button, which opens the Manual Performance Tuning dialog box. If you clear the check box for...
Dynamic Tessellation, shown in figure 16, you can significantly improve the display speed of pipe networks as 3D solids. With dynamic tessellation turned off, system resources are not used to store surface tessellation in memory for different zoom levels. To compensate for this setting, after you have set your 3D display to the desired zoom level, regenerate the display (REGEN) to synchronize the tessellation level.

Figure 16: Dynamic tessellation settings

Variable Settings

The following variables are useful for optimizing system performance.

**GRIPOBJLIMIT**

*Function:* Specifies the maximum number of selected objects that can display editing grips. Default setting is 100.

*Recommended setting:* 2
**HIGHLIGHT**

**Function:** Specifies whether objects you select in the drawing are redrawn with dashed lines for easier visibility. Default setting is 1 (on), but you can set it to 0 (off) for faster selection of large, detailed objects. The 0 setting is especially effective for working with surfaces that include many contours or other lines.

**Recommended setting:** 0

**ISAVEPERCENT**

**Function:** Controls the amount of unused space in a drawing, measured in percent. Default setting is 50. With a setting of 0 the drawing size is minimized, but every save operation is a full save.

**Recommended setting:** 0

**SAVETIME**

**Function:** Specifies the time interval in minutes between automatic save (Autosave) operations. Default setting is 10 minutes.

**Recommended setting:** 30 or more

### Drawing Settings

Configure the following settings in your drawing templates so that they apply consistently for all drawings created from the templates.

**PROXYGRAPHICS**

**Function:** Specifies whether to save proxy graphic images in the drawing. Proxy graphics require space in the drawing file and are required only for display in applications other than AutoCAD Civil 3D. If you do not need to share drawings with users of AutoCAD or other AutoCAD-based applications, you can save space by turning off proxy graphics. If you do need to share drawings with AutoCAD users, consider using the Export to AutoCAD option, which explodes AutoCAD Civil 3D objects to AutoCAD primitives.

**Recommended setting:** 0 (off).
REGENMODE

**Function:** Specifies whether the REGEN (regenerate) command runs automatically (1) or manually (0). REGEN can be time consuming on a large drawing, so it is advisable to run it manually, when required.

**Recommended setting:** 0

VIEWRES

**Function:** Specifies the circle zoom percent value, which determines the smoothness of displayed curves. Valid values are integers from 1 to 20000; default is 1000. Setting a lower number causes faster system performance in REGEN operations.

**Recommended setting:** try 50, then adjust up or down to suit requirements

---

Use Appropriate Data Resolution

Review the requirements for data precision and coverage in the final drawings and other project deliverables. Compare these with the resolution of input surface data, especially if it comes from a DEM (digital elevation model) or LIDAR (light detection and ranging) source. Ensure that your project does not contain overly detailed surfaces that require long processing time at every step. You can either purchase a lower resolution file from the vendor, or filter the file on input to reduce data density. For more information, see Filtering Point Files (page 84) in the Surface Data chapter.

Look for ways to reduce the data density in non-critical regions of the project.

- The project may span a wide geographic area, but the design activity is focused along a few narrow corridors.
- The project contains undeveloped regions, which can use surface data of a lower resolution.
- The project area may include large flat areas with little topographic relief. These areas too could be represented with data of lower resolution.

---

Suppressing Tooltips

Your computer can use a lot of resources to display tooltips for each location of the cursor in the drawing window. If all tooltips are enabled, the cursor will display one or more surface names, elevations, and offset distances from...
multiple alignments. You can reduce the number of tooltips by changing the tooltip setting at the level of the drawing, the object type, or the specific object. For example, you can selectively show tooltips from some objects while suppressing them from others. For more information, see Object Tooltips.

Accessing More Windows RAM

64-bit Operating Systems

For best performance, it is recommended to use the 64-bit version of AutoCAD Civil 3D 2011. On a 64-bit operating system, AutoCAD Civil 3D is able to use whatever system memory is available (virtual memory and physical memory). Using AutoCAD Civil 3D on a 64-bit operating system will therefore provide better performance for memory-intensive tasks.

NOTE For 64-bit operating systems, optimal memory usage can be obtained by setting your virtual memory to twice the amount of physical memory you have. For example, if you have 4 GB of physical RAM, set your virtual memory to 8 GB. If you have a need for more memory, you will obtain better incremental performance if you add more physical memory rather than simply increasing the virtual memory over the 2:1 ratio. For example, increase your physical memory to 6 GB and then increase your virtual memory to 12 GB.

32-bit Operating Systems

The 32-bit Windows operating system typically does not allow an application to use more than 2 GB of system RAM. To facilitate working with large data sets, you can increase this limit to 3 GB if your computer has 4 GB or more of physical RAM installed. This change has not been tested on all system configurations, so it is not supported by Autodesk. However, you can test it with your system, and if you encounter problems, switch back to the 2 GB limit. For more information, see the document The 3 GB Switch and AutoCAD Civil 3D on the AutoCAD Civil 3D Services and Support website, at this link: http://usa.autodesk.com/getdoc/id=TS1071001.

Simplify Profile and Section View Styles

To minimize processing time, design your profile and section views on grids that use styles without excess detail. Some examples are as follows:

- Turn off the minor grid lines and ticks
Expand the scale of the major grid
Avoid using clipped grid options
Keep label text very short

Where necessary, apply more detailed styles to any of these elements for final production, but use minimal display styles in the design phase.

Section View Production

A large project often involves the need to display many section views. AutoCAD Civil 3D includes a feature for separating the corridor model from the display of section views in a production drawing. The process is as follows:

1. In the corridor drawing, create a data reference for each alignment that is used as a baseline for the corridor.
2. In a new section view drawing, insert the alignment references, and attach the corridor drawing as an xref.
3. Create sample lines in the section view drawing, and generate the section views.

Maintaining Clean Drawings

As part of the project team’s work process, you can use a number of standard AutoCAD operations to eliminate redundant data from project drawings.

Check for Drawing Errors

The Audit command checks for errors in an open, active drawing. To run the command, click Application Menu ➤ Drawing Utilities ➤ Audit.

Remove Unused Data

Two purge commands are available to remove unused data from your drawings.

- The main command removes nested, unused features. To run the command, click Application menu ➤ Drawing Utilities ➤ Purge.
A secondary command removes unused registered applications (regapps) from a drawing. To run this command, enter `-purge` on the command line, then enter the command option “r” to remove regapps.

**Locate Redundant Objects**

The AutoCAD command QSELECT is useful for finding redundant objects in a drawing, as long as you have some idea of what to look for. For example, if you have been creating alignments and know that your drawing contains four actual alignments, you could use QSELECT to select all alignments. Then if the list includes more than four, you can delete the extra ones.

**Repair Drawings**

The Recover command locates and repairs damaged data in a drawing. The command is intended to be run when you open a drawing. Click Application menu ➤ Drawing Utilities ➤ Recover, select the drawing, then click Open.

**Map 3D Cleanup**

A powerful utility developed for AutoCAD Map 3D is also included with AutoCAD Civil 3D. It enables you to delete duplicate objects, weed polylines, and do many other cleanup actions. You can set several parameters to control each action. Access the cleanup tools in one of two ways:

- At the bottom of the drawing window, click Workspace Switching and click either Tool-based Geospatial or Task-based Geospatial. On the ribbon, click Tools tab ➤ Map Edit panel ➤ Clean Up.
- On the command line, enter MAPCLEAN.

The Drawing Cleanup dialog box opens, as shown in figure 17.
NOTE While you can run several actions together, it is recommended that you do them one at a time for better monitoring and control.

Delete Corrupt Data

If you have a drawing that is corrupted and cannot be fixed by other means, you can use the Write Block (WBlock) command to write all drawing objects to a new drawing file. This can eliminate the corrupt data, and reduce the file size.

Several precautions apply when using WBlock with AutoCAD Civil 3D data:

- Do not specify an insertion point, as doing that would change all the coordinate positions.

- If the drawing contains many AutoCAD Civil 3D object or large objects, you may need to use alternative methods: export the data to LandXML, and then import it into a new drawing, or Export to AutoCAD, which explodes the AutoCAD Civil 3D objects. If the objects are exploded and you want to re-create them, you may be able to use the exploded polylines or other simple entities as a starting point, or you may need to start from scratch.
If you also want to copy sheet layouts from the drawing, use the AutoCAD DesignCenter tool to drag-and-drop them to the new drawing.

**Remove Unneeded Objects**

The Zoom Extents command enables you to see whether the drawing contains any unwanted objects outside the main design area. If so, you can delete them and reduce the drawing size.

### Preparing Final Plan Drawings

Consider the following best practices guidelines when using plan production tools:

**Sheets Per File**

In some situations it can be beneficial to save a single sheet per file, so that many users can work on different sheets at the same time.

If you choose to save more than one sheet per file, for optimum performance it is recommended that no more than 10 sheets be saved to a file.

**Labeling Data in Sheets**

It is recommended that you add labels to your plan drawings in the sheet file. This is why data references are used in the Create Sheets wizard. Using this approach you can more efficiently add and maintain labels that are appropriate for finished construction documents.

**Prepare Profile View Styles and Band Sets Before Creating View Frames**

It is recommended that you create and choose the desired style for your profile views and band sets before using the Create View Frames wizard. This way, when you use the Create View Frames wizard, the style that you want for your profile views and band sets in sheets can be selected when you create the view frame group.

It is also important to understand that if you launch the Create Multiple Profile Views wizard from within the Create Sheets wizard, many features of the Create Multiple Profile Views wizard are not available.

For example, the General, Station Range, and Multiple Plot Options pages of the Create Multiple Profile View wizard are not available when you launch the Create Multiple Profile Views wizard from the Create Sheets wizard.
These features are not available here because these settings were already selected during the creation of view frames—when you used the first few pages of the Create View Frames wizard. The calculation of the extents of what could fit into the template’s viewports are defined during view frame creation, and in fact are dependent upon these settings. These settings ensure that the view frames are correctly laid out.

If you want to change profile view settings that are not available for editing during the sheet creation process (such as the profile view style or band set), you need to edit these settings during creation of the view frames (while using the Create View Frames wizard). Therefore, you may need to delete the view frame group and recreate it using the desired profile view settings.

**Add Scale Factor to Layout Name**

When naming the layouts that you use in plan production templates, you may find it useful to add the scale factor that was used in the viewports to the layout name. The following illustration shows an example of a layout name that includes the scale factor used in the viewport—ANSI D Plan and Profile 40 Scale.

![Figure 18: Layout name that includes the scale factor](image)
Survey Data

This section describes best practices for working with survey data including preparing to import survey data, importing data, creating surfaces from survey data, and importing point coordinates from a field book file.

Setting Up and Working with Survey Data

The following example is based on a case study conducted using Trimble and Leica survey data collection equipment. A small site survey was performed to demonstrate that raw survey data from equipment providers can be converted and imported into AutoCAD Civil 3D. These companies, and others, directly support AutoCAD Civil 3D and demonstrate an advantage that AutoCAD Civil 3D has by using the field book file data format.

This section describes best practices for preparing to import survey data into AutoCAD Civil 3D. For more information about Survey Field to Finish, see Survey Field to Finish in the Help system. The basic recommended sequence is as follows:

1. Create a code set list in each controller to collect data in a consistent manner. Use a single coding standard such as the codes shown here that were used to code the sample field data.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station</td>
<td>STN</td>
</tr>
<tr>
<td>Football pitch</td>
<td>FP</td>
</tr>
<tr>
<td>Bank Bottom</td>
<td>BB</td>
</tr>
<tr>
<td>Building</td>
<td>BG</td>
</tr>
<tr>
<td>Entity</td>
<td>Code</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Drop Kerb</td>
<td>DK</td>
</tr>
<tr>
<td>Electricity Pole</td>
<td>EP</td>
</tr>
<tr>
<td>Fence</td>
<td>FE</td>
</tr>
<tr>
<td>Gate</td>
<td>G</td>
</tr>
<tr>
<td>Gulley</td>
<td>GU</td>
</tr>
<tr>
<td>Hedge</td>
<td>HE</td>
</tr>
<tr>
<td>Inspection Cover</td>
<td>IC</td>
</tr>
<tr>
<td>Kerb</td>
<td>K</td>
</tr>
<tr>
<td>Lamp Post</td>
<td>LP</td>
</tr>
<tr>
<td>Manhole</td>
<td>MH</td>
</tr>
<tr>
<td>Manhole-Rectangular</td>
<td>MHRECT</td>
</tr>
<tr>
<td>Marker</td>
<td>MK</td>
</tr>
<tr>
<td>Overhead Wire</td>
<td>OHW</td>
</tr>
<tr>
<td>Post</td>
<td>PO</td>
</tr>
<tr>
<td>Spot Level</td>
<td>SL</td>
</tr>
<tr>
<td>Steps</td>
<td>STEP</td>
</tr>
<tr>
<td>Tank</td>
<td>TA</td>
</tr>
<tr>
<td>Text</td>
<td>TXT</td>
</tr>
<tr>
<td>Tree</td>
<td>TE</td>
</tr>
</tbody>
</table>

During the field survey data collection, use the coding convention previously established in an AutoCAD Civil 3D Linework Code Set. For example, it is recommended that the linework command code come after
the linework feature name, such as "OHW B", where OHW is the figure name, and B is the begin code defined in the Linework Code Set that will be used when the data is imported into AutoCAD Civil 3D.

If your data collector does not support the use of a Linework Code Set, then a convention such as the figure command BEG is used to indicate the beginning of a figure line, such may be the case with some data collection conversion tools that do not support the new Field to Finish features of AutoCAD Civil 3D 2010.

Inserting a figure command into the point description during the survey data collection phase of a project automates the process of creating line work when the data is later imported into AutoCAD Civil 3D 2010.

3 Use the Edit Linework Code Set dialog box, as shown in figure 1, to specify coding methods and to edit special codes, line segment codes, and curve segment codes.

![Edit Linework Code Set dialog box](image)

Figure 1: Specify coding methods for consistency
NOTE It is recommended that you use <space> as the Field/Code Delimiter Property value.

4 Use the Description Key editor, as shown in figure 2, to create a suitable description key set to match these codes to style points, label descriptions, and elevations accordingly.

![Figure 2: Create description keys editor](image)

5 Use the Figure Prefix Database Manager, as shown in figure 3, to create a figure prefix library and figure styles with which to receive the linework codes and draw the linework in a suitable style.

NOTE You should only specify a site if the Lot Line property is set.

![Figure 3: Specify how imported line work is drawn](image)

You can specify whether the linework is drawn as breaklines or lot lines, as well as the assigned layer, style, and site.
The following two steps in this workflow illustrate the results of importing and working with the sample survey data. The example in this workflow is the field shown in figure 4.

6 Import the survey data. The results after importing the survey data into AutoCAD Civil 3D are shown in figure 5.
7 Create a surface from breaklines and point groups. Then specify a contour style as shown in figure 6.
This completes the survey field to finish workflow.

**Importing Survey Data**

The Survey collection equipment described in this section is compatible with AutoCAD Civil 3D.

**Use the following software to convert survey data**

- **Trimble**
  - Use the Trimble Link add-on to AutoCAD Civil 3D (available from [www.trimble.com](http://www.trimble.com)), to connect directly to the equipment controller and/or to the location where the raw .job file is stored.
  - When the data is checked in, the link will check for any alphanumeric point numbers and change them accordingly, as these are not catered for.

- **Leica**
  - The Leica X-Change software ([www.leica-geosystems.com](http://www.leica-geosystems.com)), uses the DBX database as the raw survey data format. The X-Change add-on to AutoCAD Civil 3D converts the raw format to a field book file, that can be imported into AutoCAD Civil 3D.
Adding Contour Data

You can add contour data to the composite surface from survey data.

The following workflow illustrates the option of adding LIDAR contour data to the surface created with the sample survey data. These are optional steps and may not be necessary or applicable to your design solution.

The example in this workflow is the field shown in figure 4. You can also drape an aerial photo of a surveyed field to the surface created with survey points.

1. To fill out the surface, you can use LIDAR contour data which should be set as a 5m grid dataset as shown in figure 7.

2. Create a new surface and paste the 5m grid and also the surveyed surface as shown in figure 8.
3 Using Map import, import the aerial photo of the surveyed field, which includes a “World file” for positioning at the same coordinate system used. The result is shown in figure 9.

Figure 8: Result of pasting the surveyed surface

Figure 9: Importing the aerial photo
4 Create a boundary around the aerial photo and add as a boundary to the composite surface. Then, drape the aerial photo to the composite surface with the Drape Image command.

![Aerial photo added as boundary and draped to the composite surface](image)

**Figure 10: Aerial photo added as boundary and draped to the composite surface**

**Importing Survey XML Data**

You can import survey LandXML data either into the drawing or into the survey project database.

The Import LandXML command imports data into the drawing only. This command can import reduced observations, creating points from the data. It also imports Monuments as points in a monuments point group.
The Import LandXML command accessed from the survey project on the Toolspace Survey tab imports raw or reduced observations into the survey database. You can then insert all or selected items into the drawing.

**If you want to...**

- Import reduced observations into the drawing as AutoCAD Civil 3D points.
- Import monuments as AutoCAD Civil 3D points.
- Import raw observations into the survey database.
- Import PlanFeatures as survey figures.
- Import parcels as survey figures.
- Import CgPoints as survey points.

**Then...**

- Use the drawing LandXML Import command. For more information, see Importing Survey LandXML Data.
- Use the drawing LandXML Import command.
- Use the Import Survey LandXML command.
- Use the Import Survey LandXML command.
- Use the Import Survey LandXML command.
- Use the Import Survey LandXML command.

**IMPORTANT** Using the Import LandXML command does not import survey data into the survey database. To access this command, click Insert tab ➤ Import panel ➤ LandXML ▶️.

**The following table illustrates the results of importing LandXML data using the drawing or survey LandXML import functions.**

<table>
<thead>
<tr>
<th>LandXML Data</th>
<th>Result Using Drawing LandXML Import</th>
<th>Result Using Survey LandXML Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parcels</td>
<td>Parcels</td>
<td>Figures in survey database</td>
</tr>
<tr>
<td>PlanFeatures</td>
<td>Polylines</td>
<td>Figures in survey database</td>
</tr>
<tr>
<td>COGO points, survey monuments</td>
<td>AutoCAD Civil 3D points in point groups</td>
<td>Survey points in survey database</td>
</tr>
<tr>
<td>Reduced observations</td>
<td>AutoCAD Civil 3D points in point groups</td>
<td>Observations, control points, or non-control points in survey database</td>
</tr>
</tbody>
</table>
## Importing Point Coordinates

Consider the following best practices when importing point coordinates from a field book file:

<table>
<thead>
<tr>
<th>LandXML Data</th>
<th>Result Using Drawing LandXML Import</th>
<th>Result Using Survey LandXML Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw observations</td>
<td>Not applicable</td>
<td>Observations, control points, or non-control points in survey database</td>
</tr>
</tbody>
</table>

### Importing Point Coordinates

When importing point coordinates from an FBK file, you need to distinguish between the US Survey Foot and the International Foot. If the units in your field book (FBK) file are in US Survey Foot, you must specify this in the FBK file, using the `<UNIT USFOOT DMS>` tag. Once this is done, the coordinates in the Survey database will match the FBK file values.

If the units in the FBK file are in International Foot (`<UNIT FOOT DMS>`) and the Survey database is set to a zone that uses US Survey Foot, the coordinates are converted automatically.

### Correct Field Book Syntax

When entering coordinates, you must use the correct field book "language" syntax. In a field book file, coordinates must always be entered in the following order: Northing, Easting, and Elevation. You cannot reverse this order.

This sample line contains the correct syntax for a field book file entry: **NE SS 1 200.00 600.00 100.00** or **NEZ 1 200.00 600.00 100.00**.

**NOTE** NEZ command should be used only for fixed control points, whereas NE SS should be used for numerous non-control points, such as those collected and reduced by GPS RTK surveys.
Project Management

This section describes how to organize your drawings, design objects, and work procedures to support a project team.

Project management is a “big picture” issue that affects everyone on the team. Decisions about your project management system can have extensive, long-term consequences. The first challenge is to gain a clear understanding of the planning decisions required and the information you need to make these decisions.

Visualize how a particular project management system will work when it is fully loaded with design objects, drawings, and staff members sharing files. How do you keep the system flexible and efficient while still protecting the data? A strategy that works fine with a set of 20 drawings in a month-long project can break down in a long-term project with 400 drawings. Fortunately, with AutoCAD Civil 3D, you can start with a simple system and either build it up or trim it down as project requirements change.

Organizing Your Data

The following practices are recommended for any project management system:

- Create a structure of project folders and files so every member of the team can readily find the data files they need, and save all drawings in the right place.

- Apply meaningful, specific names to all files and objects that are shared within a project environment. Default names such as “Alignment – (1)” can be especially confusing, because they can appear in multiple drawings, and have no reference to a real-world object.

- Establish written procedures for team members who will regularly access project files. This is particularly important if you are not using Autodesk Vault. Procedures can include the use of templates, naming conventions for files and folders, and notices when drawings are being modified. Encourage team members to communicate anything that might affect others.
For basic design objects such as surfaces and alignments, consider saving one object per drawing for maximum flexibility. This drawing structure enables one team member to open a drawing for edit while other members can operate with read-only copies. However, there are exceptions to this structure. On a small project, you may decide to store several objects in the same drawing if they will always be edited by the same person. For example, it often makes sense to keep a set of related alignments in a single drawing.

**Data Storage: Vault or Not**

With AutoCAD Civil 3D, you have a choice of data storage mechanisms. Autodesk Vault is supplied with AutoCAD Civil 3D. It provides a secure and comprehensive data management solution, but requires formal database management and usage procedures. In most cases, it also requires a dedicated server.

You may want a simpler system. If so, you can store your projects in folders, and manage them in your own way. You must also establish procedures to ensure that data is not unintentionally deleted or changed. These procedures can be quite easy and safe for a small design team in which people have no need for shared access to many drawings and in which they keep in touch with each other's activities.

For larger teams with a lot of design objects shared across many drawings, Vault may provide a better solution. To really settle this question, you need to understand your data referencing strategy and object relationships within a typical project.

To get acquainted with Vault, you can install it on a networked server or your own computer, experiment with using it, and review the documentation. You probably want to use Vault if you are interested in any of these features:

- Secure document locks and version control
- Assignment of user roles and file access permissions down to the level of folders within projects
- Automated data backup and restore operations
- Project labeling and archiving mechanism
- Management of data at multiple geographic sites within a single database structure
Drawing and Object Relationships

For all but the smallest projects, it is a best practice to maintain master drawings of common design objects, such as existing ground surfaces and alignments. These objects can then be referenced into other drawings as lightweight copies of the original, requiring very little space. The practice of referencing also protects the source data from unintentional changes, because the referenced objects are read-only copies. The source data cannot be changed in the host drawing.

The use of references leverages the dynamic relationships between objects. When a source object is edited, these changes automatically flow through all referenced copies in other drawings. You can use three types of referencing with AutoCAD Civil 3D:

- Autodesk Vault
- Data shortcuts
- AutoCAD external references (xrefs)

For more information, see Data Reference Types (page 57) in this chapter.

As you create data references between project drawings, you construct a network of drawings. If you are working on a large project with many people, this network can become confusing and difficult to manage. To reap the benefits of data references, it is important to plan the drawing relationships in advance, and actually create a diagram for the project team to reference.
Figure 1: Three-level project drawing structure

Figure 1 shows a sample project structure. You can use this three-level structure with Vault or with data shortcut projects. The following sections describe how to set up the different levels.

**Level 1: Individual Design Objects**

In the first level of the project structure, set up the source drawings that contain basic design objects, such as existing ground surfaces, alignments, and parcel networks. You can either store each object in a separate drawing or include several related objects in a single drawing.
One Object Per Drawing

Keeping each object in a separate drawing is recommended for large projects. This structure ensures that users can edit objects while not preventing access to other objects by other users. This isolation of objects also minimizes the possibility of a user editing an object and accidentally affecting other objects in the same drawing.

Multiple Objects Per Drawing

Group multiple objects in a single drawing for small projects, or whenever one user is solely responsible for the entire design. For example, you could manage all of the related alignments in a subdivision design in a single drawing, and manage the parcel network in another drawing. This project structure reduces the number of drawings to manage. However, there is a risk of accidental changes to objects.

Data Referencing

Use data references between your Level 1 drawings to share read-only copies of objects, such as the existing ground surface. These references can be either Vault references or data shortcuts, depending on your structure.

Explicit Naming

For each drawing, create a unique file name and save it to the designated project working folder. It is recommended that you name each drawing with a clear reference to the object it contains (for example, Maple_Street_Centerline.dwg). As the number of project drawings increases, the wisdom of using explicit references in the file names becomes more apparent.

Level 2: Base, Linework, and Engineering Drawings

After you have created the design objects, you can create several types of drawings in Level 2 of the workflow, including base, linework, and engineering drawings.

In a multi-user environment, engineers and designers can reference core project objects into composite drawings, keeping the drawing size small, and ensuring that core objects are not unintentionally modified. At the same time, technicians and drafters can create plan sets and production drawings as required.
**Base Drawings**

You create base drawings, such as a utility base or grading base, by combining data references from Level 1 drawings. You can use base drawings to show the existing conditions on a site, and then xref this drawing into a site features plan or a plan set.

**Linework Drawings**

Creating linework drawings is sometimes an intermediate step between developing engineering plans and base drawings. Linework drawings contain the linework and AutoCAD objects (such as lines, text, and blocks) that are used to build or represent existing conditions. Although linework drawings do not include AutoCAD Civil 3D objects, you can still add linework drawings to the project so that you can manage and reference them later on in the workflow.

**Engineering Plans**

Engineering plans, such as corridor designs, grading plans, or site plans, result from combining design objects to create other design objects for your project. For example, in a corridor model drawing, you can keep the drawing at a manageable size by using data references to bring in the alignment and profile from their source drawing, and the existing ground surface from its source drawing.

**Level 3: Production Sheets**

After you have developed the relevant base, engineering, and linework drawings, you are ready to create a production sheet or a plan set drawing, such as a plan and profile, utility sheet, or landscaping sheet.

To generate these top-level sheets, xref your base, engineering, and linework plans together into a plan set drawing that can be used for generating layouts with title blocks and final drafting. If you use Autodesk Vault, before you xref these drawings, ensure that their latest versions are in your working folder.

**To get the latest version of Autodesk Vault project data**

- On the Toolspace Prospector tab, right-click the project name ➤ Get Latest Version.
This operation pulls the most recent versions of all project drawings and design objects into your working folder. After you have these latest versions, you are ready to create level 3 production sheets.

**Create the Plan Set Drawing**

Let’s assume you are working on a plan and profile sheet. First, create a new drawing, name it, and save it to your working folder. Then, externally reference the appropriate Level 2 drawings, such as base linework, base utility, and base topology. When you create a Level 3 drawing, the Level 2 object data and label styles are display-only. However, you can use Layer Manager to selectively hide and display layers within the Level 2 data.

If you use Vault, be sure to use the option Include All File Dependencies when you check in the plan set drawing. This ensures that all associated file dependencies are copied to their working folders when other team members check out the plan set drawing.

You typically use a plan set drawing with Sheet Set Manager (SSM) in AutoCAD Civil 3D. To create individual sheets in SSM, you create AutoCAD views within your plan set drawings. For more information about SSM, refer to the online help in AutoCAD Civil 3D.

**Additional Drafting and Annotation**

You can data reference individual design objects into a plan set drawing and apply any required annotation or drafting. This process leverages the work done in Level 1 and Level 2 drawings. In addition, drafters and technicians can finalize the annotation for the Level 3 sheets as part of a full set of construction documents.

**Addressing Interference**

When drawings from Level 1 and Level 2 are externally referenced into Level 3, you may find that there are annotation overlaps, duplication, or other interferences. You can use Layer Manager to turn off interfering text, or you can create a data reference of the design object in the Level 3 drawing and control its annotation there. Using this approach, the Level 3 drawings can be synchronized to reflect changes that take place in lower levels. While creating references in Level 3 requires some duplicate work, it is negligible compared to the benefit of synchronizing the Level 3 sheets with the original design.
Working with Images

You may need to incorporate an image in a production sheet. For example, a rough grading plan sheet can include aerial photographs. You can attach an image using the External References Manager.

Bypassing Level 2

You may be able to complete some projects without using all three levels of the workflow. In particular, you may not need the intermediate drawings in Level 2. Instead, you may be able to create Level 3 sheets by data referencing individual objects from drawings created in Level 1. You benefit in bypassing Level 2 drawings because you can create labels directly in the Level 3 drawings, and avoid the possibility of generating interference. However, bypassing Level 2 has a downside because you cannot combine objects from Level 1 with design objects such as corridors or utility networks in separate drawings.

Digging It: Three-Level Project Structure

Mike Bandich and Danny Counts of U.S. CAD originally developed the project structure described in this document. Here Mike explains how they have used and adapted the structure for different projects.

“After hearing about Vault for the first time in 2006, I was enthusiastic about its possibilities for project-based collaboration,” explains Mike Bandich. “During a break at Tech Camp, after my first introduction to Vault, I began to discuss a potential workflow with Danny. Out of that conversation arose the concept that developed into the project drawing structure.

“In my opinion, the concept can be applied to any civil engineering project that uses Vault with any of the shared AutoCAD Civil 3D objects. I have personally applied this structure to a range of design projects, including street improvements, sewer and storm water networks, and residential grading.

“We proposed the concept of one object per drawing because this model offers the greatest flexibility for project teams large and small. In practice, some project teams have decided to combine multiple objects into a single drawing. For example, some have decided to put all the horizontal control (alignments) into one drawing.”

Contact Mike or Danny through their corporate website (http://www.uscad.com) or by dialing 1-877-64-USCAD. See Danny’s blog at http://digginginc3d.blogspot.com.
Sample Project Structure

The following table shows how you can use data references and external references to share data among the drawings of a typical project.

<table>
<thead>
<tr>
<th>Drawing or File</th>
<th>Data References</th>
<th>External References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey.dwg</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>Existing Ground (EG).dwg</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>Parcels.dwg</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>Alignment.dwg</td>
<td>none</td>
<td>Parcel.dwg, Existing Ground.dwg</td>
</tr>
<tr>
<td>Profile.dwg</td>
<td>EG surface</td>
<td>none</td>
</tr>
<tr>
<td>Corridor.dwg (Source dwg for Corridor surface)</td>
<td>EG surface, Alignment, EG profile, Finished Ground (FG) profile</td>
<td>none</td>
</tr>
<tr>
<td>Proposed Grade.dwg</td>
<td>EG surface, Corridor surface</td>
<td>none</td>
</tr>
<tr>
<td>Sections.dwg</td>
<td>Alignment</td>
<td>Corridor.dwg</td>
</tr>
<tr>
<td>Pipes.dwg</td>
<td>Proposed Grade surface, Alignment</td>
<td>Parcel.dwg</td>
</tr>
<tr>
<td>View Frames.dwg</td>
<td>Alignment</td>
<td>Parcel.dwg</td>
</tr>
<tr>
<td>Sheet Compilation.dwg</td>
<td>EG surface, Alignment, EG profile, FG profile, Proposed Grade, Pipe Network</td>
<td>Corridor.dwg</td>
</tr>
<tr>
<td>Sheet Set.dst</td>
<td>none</td>
<td>Sheet Compilation.dwg</td>
</tr>
</tbody>
</table>

Data Reference Types

AutoCAD Civil 3D supports three reference types:

- Vault references
- Data shortcuts
AutoCAD external references (xrefs)

Vault references and data shortcuts can be used for project surfaces, alignments, profiles, pipe networks, and view frame groups. Vault projects can be converted to data shortcut projects, and data shortcuts projects can be converted to Vault projects. AutoCAD external references can be used with any drawing, regardless of contents. Each reference format is explained in the following sections.

Autodesk Vault Overview

Autodesk Vault is the recommended project management option for large design teams working with AutoCAD Civil 3D.

The main database resides on a designated server, such as a file server on the network, and client software is installed on each computer that requires access to the database.

Using Vault, you can share surfaces, alignments, profiles, pipe networks, points, view frame groups, and survey data.

For more information, see Using Vault.

Vault Project Structure

Vault references are used only within Vault projects, and they are restricted to use within a single project. To use these references across multiple project phases or across different engineering projects, you can create folders for separate engineering projects within a single Vault project folder.
As shown in figure 2, projects NE and NW are within a single Vault project called North. Vault references can link to any object within the North project folder. If you need to extend these references to other projects, create new folders for these projects inside the North project working folder. Replicate the project structure in Vault, using the Autodesk Vault administration tool.

You can use subfolders to organize the folders for drawings and documents, but not other project objects, such as the reference links in Prospector or the Vault database files (*project.xml, PointsStatus.mdb, PointsGeometry.mdb, Survey.sdb and Survey.sdx*).

**Advantages of Autodesk Vault**

- This robust database management system provides user security, data integrity protection, version control, and backup and restore functionality.
- Vault facilitates design collaboration among large teams and it is easily scalable when a team grows.
- Vault incorporates new features from Autodesk and Microsoft as they become available with software upgrades.
- Vault manages shared objects when checking a drawing into the database.
- You can use project templates when creating projects in Vault.
- An optional multi-site Vault feature supports the sharing of individual vaults by workgroups in separate geographical locations. This feature supports the same data management and backup functionality that Vault provides on a local network.

**Limitations of Autodesk Vault**

- Vault requires at least double the disk space needed by other project management systems, because all files exist both in the Vault file store, and in one or more external working folders.
- It requires ongoing server administration activities.

**Best Practices**

- Designate one team member to be trained as a system administrator and to perform administrative duties regularly.
- Assign database access permissions to user groups rather than to individuals. As a result, you can change the permissions for an entire group, or change users’ permissions by moving them to another group.

**Sample Uses**

- Reference a surface and an alignment into a drawing where you want to design a parcel network. The parcel design can read the surface and alignment geometry. You can also apply display styles and labels to the surface and the alignment that are relevant to the parcel design process.
- Reference several profiles and a surface created from a corridor to create a plan set drawing.

**Data Shortcuts Overview**

Data shortcuts provide complete reference copies of objects that you can insert into one or more other drawings.
If you are unsure about your need for Autodesk Vault, start with data shortcuts. If you decide to introduce Vault later in the process, you can import your data shortcut projects into Vault. In the process, data shortcuts are automatically converted to Vault references.

Data shortcuts can be created only for surfaces, alignments, profiles, pipe networks, and view frame groups. They provide reference links between drawings without the use of a database. When you create data shortcuts from a drawing, they appear on the Data Shortcuts node of the Prospector tree. From this location, you can insert a reference object into another open drawing by right-clicking its shortcut.

Objects in the consumer drawing can access the geometry of the reference object in the data shortcut. This geometry can be modified only in the source drawing. However, display styles and labels for the reference object can be modified in the consumer drawing.

The working folder represents a single work environment, including the complete set of related drawings and data shortcuts for one or more engineering projects. The Data Shortcuts node on the Prospector tree displays only the shortcuts from the current working folder. Each shortcut is defined in a small XML file, stored in the _Shortcuts folder of the working folder. Most users do not need to work with these XML files.

When an object is updated in the source drawing, notification appears in the main application window and on the Prospector tree.

For more information, see Using Data Shortcuts.

Advantages of Data Shortcuts

- Shortcuts provide a simple, direct mechanism for sharing object data that is based solely on drawings, without the added server space and
administration needs of Autodesk Vault. This can be ideal for small teams or small projects.

- They offer access to an object’s geometry in a consumer drawing while ensuring that the object’s geometry can only be changed in the source drawing.
- Reference objects can have styles and labels that are different from the source drawing.
- Reference objects automatically update when you open a file in which you have referenced data.
- During a drawing session, you are notified when a source drawing has been modified, both in the Communication Center, and in the Prospector tab of Toolspace.

**Limitations of Data Shortcuts**

- They cannot provide data versioning.
- They provide no security or data integrity controls.
- Unlike Autodesk Vault, data shortcuts do not provide a secure mechanism for sharing point data or survey data.
- Maintaining the links between the references and their source objects requires fairly stable names and locations on the shared file system. However, most broken references can be easily repaired.

**Best Practices**

- To minimize broken references, do not move or rename shared objects or their source drawings after creation. You can move an entire working folder.
- If you need to move or rename multiple objects or data shortcuts in a working folder, use the stand-alone Data Shortcuts Editor. Avoid making direct edits in the shortcut XML files, because this can corrupt the files.
- In a network environment, use UNC paths to provide a flexible but accurate path to each working folder.
Sample Uses

- Reference a surface and a pipe network into a drawing where you want to design a grading plan. You can grade to the target surface even though it is just a reference.

- Reference a surface and a related alignment into a drawing where you want to create profiles in a profile view. Using this data structure, you can keep profiles in a separate drawing from the alignment in accordance with the best practice of “one object per drawing”.

External References Overview

An external reference (xref) inserts the entire contents of another drawing into the current drawing as a display-only object.

External referencing is a standard AutoCAD function, using commands XATTACH and EXTERNALREFERENCES. On the ribbon, click View tab ➤ Palettes panel ➤ External References Manager.

You cannot edit objects in the referenced drawing, but you can use Layer Manager to control the display of separate components.

For more information, see the AutoCAD help topic Attach Drawing References (Xrefs).

Advantages of Xrefs

- Xrefs are versatile and easy to use for different DWG types, whether they contain a single object or a complete design.

- Updates to the external drawing appear automatically in the host drawing when the drawing is opened, and notification of updates is provided during the host drawing session.

- You can apply labels to objects within an xref.

- All the content of the reference drawing is displayed, such as a parcel layout, or existing ground surface contained in a base drawing.

- Corridor data is accessible inside an xref. When you create a sections drawing, you can use an xref to bring in the corridor drawing and a data reference to bring in the required alignment.

- Xrefs can be used with either data shortcuts or Autodesk Vault.
- In Vault, an xref DWG is automatically checked into the project along with the DWG that includes the xref. You can check out the xref DWG independently. When Vault is installed, the Xref Manager in AutoCAD Civil 3D also shows the Vault status icons for each DWG.

**Limitations of Xrefs**

- Because xrefs are display-only, they provide no access to object data, such as surface elevations or alignment length. For example, you cannot create a surface profile from a surface in an xref. Both data shortcuts and Vault object references provide access to object data.

- Xrefs provide no inherent security. Anyone can break links by moving or renaming referenced files.

- When a Vault DWG contains an xref, you must perform all Xref Manager user operations in the parent DWG, not the xref DWG.

**Best Practices**

Select Relative Path as the path type when creating xrefs. Where all document users share the same network environment, use UNC (universal naming convention) paths to provide a flexible but accurate path to each referenced file.

Xrefs are best used when you will not need to manipulate objects within the referenced file. For example, when you import drawings of adjoining surfaces into plan sets. Also, xrefs are a good way to display parcels or other polygonal data as an overlay to a design.

**Sample Uses**

- Display a parcel layout within an alignment drawing.

- Display existing ground information within a design drawing.

- Display adjoining project phases in a plan set drawing.

For more information on xrefs, see the AutoCAD Help topic *Reference Other Drawing Files*.
User Access Controls

For any project team, and especially for a large one, you can protect your data by creating an organized system of access permissions to project folders. Typically you assign read-write access at the project level, and then apply restrictions to sub-folders within a project. It is usually most efficient to apply permissions to user groups rather than individuals. For example, your project team could include Surveyors, Civil Engineers, and CAD Technicians.

Figure 4: Group permissions example

Figure 4 uses bidirectional arrows to signify read-write access, and unidirectional arrows to signify read-only access:

- Surveyors are the only ones with write access to the folder that contains land surfaces. The Surveyors have read-only access to the folder that contains drawings of alignments, parcels, and other civil design objects.
- Civil Engineers have read-only access to the land surfaces and production drawings, but write access to the civil design objects.
- CAD Technicians have read-only access to the engineering design folder, but write access to the production drawing folder.

Access controls of this type are a standard administrative function in Autodesk Vault. You can configure them using the Autodesk Vault administration tool. If you are not using Vault, you can set permissions within the Microsoft® New
Technology File System (NTFS), using the Sharing and Security settings at the folder level. Consult with your system administrator to set up an effective strategy. For any such strategy, it is a best practice to create several user groups or roles and configure the folder access for these groups. Then you can add individual users to a group to acquire the appropriate permissions, and move them to another group, as required.

**Project Folder Structure**

The structure of project folders is designed to keep all your documents organized and easy to find for all team members. As the number of drawings and other documents increases, the folder structure becomes more important for maintaining productivity and ensuring that nothing gets lost. The data references between drawings include path names, so you must maintain the names and folder locations of the drawings to preserve the references.

**Autodesk Vault Projects**

If you use Autodesk Vault, each time you create a project you are offered the choice of a project template, which is a standard hierarchy of named folders. It is recommended that you examine the default template (_)Sample Project) and either use it or create a modified version to suit your project needs. The default location for project templates is C:\C3D Project Templates.

To create your own template, copy the default version, modify the folder names and hierarchy, and save it in the same directory with a different name.
Data Shortcut Projects

If you use data shortcuts, a standard project folder structure is still a best practice. You can use the default template (_Sample Project) and create your own versions.

**Default shortcut project template: icons on the Prospector tree**

- **Data Shortcuts [C:\Civil 3D Projects\Arc]**
  - Surfaces
  - Arealc
  - Alignments
  - Pipe Networks
  - View Frame Groups

**Default shortcut project template: folder structure in the working folder**

Keep the top-level _Shortcuts folder and its object-specific subfolders as the storage location for shortcut XML files, but feel free to create other folders for drawings.

Working Folder Location

Projects in Autodesk Vault and those with data shortcut references each use the concept of a working folder for storing all projects. For data shortcut projects, the working folder contains the actual project documents. For Autodesk Vault, the working folder contains replicas of original documents from the database.
The default working folder location for both types of projects is \C3D Projects. This location is fine if you use either Vault or data shortcuts for all your projects. However, if you work with both types of projects, you should keep the project types separate for ease of administration. One simple solution is to name your Autodesk Vault working folder \C3D Vault Projects and name your data shortcut working folder \C3D Shortcut Projects.

**Sharing and Transferring Files**

You can use several strategies for sharing files between members of a project team, sending files to clients, and archiving files.

**Project Import and Export**

Autodesk Vault provides a convenient mechanism for safely moving projects between vaults. You can select a project on the Prospector tab and export it to a single ZIP archive. This archive can be transferred as required, and then imported into another vault. Access the import operation on the Projects node of the Prospector tab. In addition to importing Vault projects, the import operation can import a data shortcuts project and convert all shortcuts to Vault references.

If you have a few drawings with data shortcuts and want to add these to a Vault project, you can simply add them using regular Vault operations. Broken references will be detected, and after all related drawings have been added, these references will be resolved.

**eTransmit**

Use this standard AutoCAD function to send AutoCAD Civil 3D drawings and referenced objects to a client or remote team member. eTransmit is also useful for transferring drawings from one project to another. All drawings required to support the data references are automatically included in the package. The receiving computer must have the AutoCAD Civil 3D Object Enabler installed, or a full version of AutoCAD Civil 3D.

**TIP** eTransmit is ideal for submitting finished drawings or conducting technical reviews with markups. It can also capture edits to the main drawing, and update the central version. However, edits to the referenced drawings are less reliable.
Autodesk Vault Setup

If you use Autodesk Vault, you need to make several decisions about the configuration of vaults and projects. These are described in the following sections.

Single or Multiple Sites

Choose a network architecture to match the spatial distribution of your team. You can configure Autodesk Vault for a single office site as shown in figure 5.

![Figure 5: Single Site Vault architecture](image)

Autodesk Vault can also manage project data for users at multiple sites as if they were all working in the same office. This capability is provided by a multi-site option, available with Autodesk Vault at extra cost.
Figure 6: Multi-site Vault architecture

As shown in figure 6, a multi-site Vault installation uses a single instance of SQL Server to manage files for two or more sites. Each database—also referred to as a “vault”—is typically replicated at each site to facilitate file sharing, but not all files are copied. Individual files are distributed to users as needed. SQL Server keeps track of where copies of files exist and ensures that these are updated or that users are notified of changes. Database administration tasks for the entire network can be managed from any location.

If your business is distributed across several office locations, the data management and security benefits of multi-site Autodesk Vault may be very useful. For more information, see the *Autodesk Vault Implementation Guide*.
Creating Additional Vaults

Determine the optimum number of vaults for your projects.

When you first install Autodesk Vault, you automatically create a single vault. This can serve as your “sandbox” or test database for experimenting with Vault operations. Work with sample data that you can practice deleting and restoring without worrying if something gets lost. It is a good idea to retain this test vault for ongoing purposes of training staff and testing new operations.

Your database administrator uses ADMS Console to create a new vault for real project data. Each vault can store many projects, so you may not need more than one new vault. The key point to remember about vaults is that they are separate databases. Each user can log into only one vault at a time. Backup schedules and other administrative operations are configured separately for each vault.

It is a good idea to create separate vaults for separate teams that do not share data. Recommended times to create a new vault for a single team are as follows:

- When your existing vault is getting so large that administrative tasks are very time-consuming
- When you start a new set of projects that do not require data from the older projects

If necessary, you can export a project from one vault and import it into another at any time.

Single Vault

The simplest way to organize your projects with Autodesk Vault is to use a single vault to store all projects and their information. All team members have access to this one location; you set up access control and user names only once. A single vault keeps project data centralized and easier to manage.

Using a single vault for all projects makes sense for a small single office or teams that are connected through a local area network (LAN). Using a single vault, you reduce both your IT and project management overhead. If your organization has multiple offices connected through a wide area network (WAN), you can still employ a single vault, but with multiple sites. For more information, see Single or Multiple Sites (page 69).

However, a single vault can become unwieldy over time. As the amount of project data increases, so do the time and space required for backup and
administration. As your vault grows, you may need to archive some older projects, or create a new vault for new projects.

Multiple Vaults

Using multiple vaults right from the beginning is recommended for large organizations with several departments that use AutoCAD Civil 3D independently. Each department—such as the survey, site, or highway departments—gets its own vault. This structure makes it easier to separately manage departmental permissions and project access.

Each vault can have a separate system administrator, and users can be granted access to only one vault, if necessary. If some users need access to multiple vaults, you must configure their permissions separately for each vault. Also note that users cannot log into more than one vault at a time.

Organizations with very large, multi-phased projects may want to assign a separate vault for each project, for ease of project management. If you elect to partition your data into multiple vaults on a server, your project teams will see shorter project lists and have tighter control over data access. However, there are some disadvantages. Projects reside in different locations and your users have to remember multiple vault names and locations. Also, backing up and maintaining multiple vaults is more work for your IT department.

Project Folders

Create folders to organize your data and to support referencing.

Within each vault, you can create any number of project folders, each using a project template, which is a standard hierarchy of folders. These Vault projects do not necessarily correspond to separate engineering projects. The key point here, as noted in Vault Project Structure (page 58), is that each drawing can be associated with only one project, and data references must remain within a project folder. Each Vault project should include all of the engineering projects that need to share data. You can always move documents between projects by eTransmit.

Working Folders

Understand how to use your local storage location for work in progress.
Drawings and other files stored in Vault are replicated on your local computer or network in what is called a working folder. The hierarchy of folders and subfolders is identical in the two locations.

**Initial Drawing Save Location**
When you create a new drawing, it is a best practice to save it in the appropriate working folder. For example, if you add a new alignment drawing, save it initially to the project subfolder that includes the other alignments. The reason for doing this is that when you later add the drawing to Vault, it will be automatically directed into the correct project subfolder.

**Working Folder Configurations**
You can set up working folders on each client computer or on the network, as described in the following sections.

**Local Working Folders**

![Local Working Folders Diagram](image)

When working folders are kept on local computers, as shown in figure 7, it minimizes network traffic and accommodates team members who may work offline from the field or a home office. Users create network traffic only when they check files in or out from the vault.

The disadvantage of this option is that the project files are stored on the local machine, making them unavailable for the backup system. In addition, using
external references (xrefs) and Sheet Set Manager (SSM) to share files is a more manual process. This set-up also requires storage capacity on each local machine to accommodate the working folder.

**Individual Network Working Folders**

![Diagram of Individual Network Working Folders](image)

**Figure 8: Individual working folders on the network**

By maintaining individual working folders on the server, as shown in figure 8, you protect each user’s work-in-progress from changes by other users. Locating these folders on the server allows for nightly backup of the data.

The drawback to having individual working folders on the server is the increase in network traffic. Additionally, if you do a nightly backup of the folders, you may have a lot more data than you really need, because you may back up multiple copies of the same files in each folder.
Multiple users can share a single working folder, as shown in the figure 9. This configuration may be more familiar, because many organizations already use a centralized data or projects folder for their drawings. In the same way you regularly back up individual working folders located on the server, you can back up a shared working folder, ensuring project data security. However, since it is a common location, the backups will be smaller in size than the backups of individual working folders.

The benefit of this configuration is that drawings with data references or external references are notified and updated every time they are saved, rather than only when they are checked back into the vault, as with the other two options. The disadvantage of the common working folder is that accidental changes can occur more easily when users work with files in the same set of folders. This approach is recommended only for small teams with members who are in close communication with each other and unlikely to be working in the same drawings.

### Autodesk Vault Project User Interfaces

Work with Autodesk Vault from within AutoCAD Civil 3D, or use a separate administration tool.

Within AutoCAD Civil 3D, you can use the Toolspace Prospector tab to interact with Autodesk Vault. Another method is to use the Autodesk Vault administration tool. In some situations, there are distinct advantages to using...
one of these methods over the other. You can also check Vault files in and out from some Microsoft Office applications.

**Prospector Tab**

You can manage project files and records most reliably when you use the Toolspace Prospector tab to create all projects. After you create a new project, it is displayed in the Projects collection in AutoCAD Civil 3D. Also, on the Prospector tab, you can view, edit, and manage drawings as well as AutoCAD Civil 3D object data stored in a vault.

You should use a project template to create a standard folder structure for all of your projects. The template “_Sample Project” is provided with AutoCAD Civil 3D and stored by default in $C:\C3D Project Templates$. If this template does not meet your needs, simply copy it, revise the folder names and structure, and save it with a different name in the AutoCAD Civil 3D Project Templates folder. Then, when you create a project, you can select your custom template. You can easily make multiple templates for different project types.

**Autodesk Vault Administration Tool**

Autodesk Vault provides a stand-alone application that you can use to manage project files and users. The Autodesk Vault tool window, shown in figure 10, uses a table to show project files and data about these files.

![Autodesk Vault window](Image)

Figure 10: Autodesk Vault window

In the tool window, you can see all project files, including system files such as `project.xml`.
The window also lists all drawings where the selected file is used as a reference and displays DWF™ versions of the drawing files, so you can quickly find the version you need.

You can use the Autodesk Vault tool to conduct many administrative activities. An Autodesk Vault administrator can delete unwanted files, set up working folders, and manage file access for individual users or groups, as described in User Access Controls (page 65).

Using the Vault tool, you can restore a previous version of a file without restoring the entire project. If you need to create a new drawing using an existing drawing as the basis, use the Copy Design option in the Vault tool to do this without opening the source drawing.

**Project Labeling**

Using the Autodesk Vault tool, you can also label project milestones for easy identification. Firms often need to submit deliverables to a client at certain levels of completion, such as 30%, 50%, and 75% completion intervals. For a 30% complete submittal, you can label all drawings in a project 30%. When you create this new label, it is assigned to the most recently checked-in version of every file in the project and all reference files. If, at a later time, you need to restore the 30% completion project files, you can easily restore the project to this milestone by simply restoring the 30% label, instead of doing it drawing by drawing.

**Pack and Go**

Another helpful administrative task using the Vault tool is Pack and Go, in which a label and all of its referenced files are combined into a single package and sent to either a folder outside the vault or an e-mail address. All files referenced by a selected label are automatically included in the package unless otherwise specified.

Use Pack and Go functionality to do the following:

- Archive a file structure.
- Copy a complete set of files, retaining links to referenced files.
- Isolate a group of files for design experimentation.
- Send a data set to e-mail recipients, such as subcontractors or clients.

Because Autodesk Vault allows you to store every file related to your project, such as Word documents, e-mails, and spreadsheets, you should also use the Vault tool to manage files that are not AutoCAD Civil 3D drawings.
It is not recommended that you use the Vault tool on a regular basis to check in or check out drawings with AutoCAD Civil 3D data. In rare cases when these drawings do need to be managed—for instance, if files are lost when checked out of a project—an administrator can force a check-in of the files through the Autodesk Vault tool.

**Microsoft Office**

When Microsoft Office is installed on the same computer as AutoCAD Civil 3D and an Autodesk Vault client, the file menu for these three Microsoft applications is automatically customized for Vault access. An Open From Vault command and an Autodesk Vault submenu are both added to the Office button, as shown in figure 11.

![Vault menu added to Microsoft Word](image)

*Figure 11: Vault menu added to Microsoft Word*

Using these commands, you can log in to Autodesk Vault and work securely with documents without leaving the Microsoft application window.
Surface Data

Surfaces are essential to most design tasks in AutoCAD Civil 3D, and because of their size, it is important to structure them for efficient processing.

Working with Large Surfaces

Follow these practices for efficient processing of large surfaces.

AutoCAD Civil 3D can build and store surfaces created from millions of points, but performance is often a problem for surfaces containing more than a million points. Such surfaces require a long time to build, edit, and draw. This section describes several ways to work more effectively with large surfaces.

Avoid Snapshots

With large surfaces, avoid creating surface snapshots; instead, retain the active links to point files, XML files, or other input data. The drawback of a snapshot is that it uses system memory, so it can double the amount of memory required for the surface.

Snapshots are more useful with small surfaces. The presence of a snapshot results in faster surface rebuilds because AutoCAD Civil 3D references the snapshot rather than redoing the operations that created it.

Controlling Surface Data Resolution

Several methods are available to reduce surface resolution, or to create variable resolution, with higher resolution in specific areas of interest.
Simplifying a Surface

This surface editing process reduces the number of points on a triangulated irregular network (TIN) surface, making the surface file smaller and easier to process. You can choose from two editing methods, and you can apply the process to the entire surface or limit it to a smaller region. The two editing methods are as follows:

- **Point removal** deletes the user-specified percentage of points from each region. To minimize the possibility of changing the surface during this operation, set a smaller value for the maximum allowed elevation change. No point will be removed if its removal would result in an elevation change larger than your set value.

- **Edge contraction** replaces the two endpoints of a triangle edge with a single point, and then redraws the triangles. This method is usually more accurate than point removal, but it takes longer to complete.

With both editing methods, points are not removed if they are on a surface breakline or border.

For more information, see Simplifying Surfaces.

Using a Data Clip Boundary

This boundary type defines a region of interest on a surface where you want to import a set of surface data. For example, you may want to import high-resolution LIDAR data along a corridor, but not on the surrounding surface. In this case, you draw a polyline around the corridor and define it as a data clip boundary. Then when you import the LIDAR data, it is added to the drawing inside the data clip boundary, but not anywhere else on the surface.

Reducing the Displayed Surface Area

Use a mask, boundary, or related settings to suppress extraneous data from the surface display.

Apply a Mask

Use a mask to display a subset of a surface. The mask boundary can be of any polygonal shape, and you can edit the shape or move the mask around like a viewing window. Surface redrawing is faster because areas outside the mask are not displayed. The entire surface remains in the drawing for reference in
surface volume calculations, and operations such as surface rebuilds continue to process the entire surface.

Create a Boundary
To reduce the processed surface area, create a smaller outer boundary around the region of your design. Areas outside the boundary are not drawn or included in calculations, but they remain in the file, available for future use. If you later need to enlarge the boundary and restore deleted portions, simply rebuild the surface. This operation requires a valid reference to the surface definition data, so you should ensure that this link remains intact.

Suppress Extraneous Graphics
Use any of the following strategies to reduce the amount of time and memory required to draw a surface:
- Set the contour interval large enough that you can see some space between distinct contours.
- Avoid using shaded display types except for small masked regions.
- Turn off the display of interior borders, and display only the exterior border.

Editing and Copying Surfaces
Avoid unexpected results in surface edit operations.
A wide range of object types and operations can participate in the creation of a surface. When the surface is copied or moved, its structure determines some aspects of its behavior within the same drawing or in another drawing. This section explains some best practices for more reliable results.

Filling in Gaps Between Surfaces
Create a smooth transition area between pasted surfaces.
If A and B are disjoint (not overlapping) surfaces, and you paste surface A into surface B, B has two separate regions. Triangles fill in the gap, but they are not visible. To make them visible, draw a polygon around the region you want to fill in, and add that polygon to the surface as a show boundary. The invisible triangles become visible, and the two pieces are joined. To complete the process, you may need to manually edit part of the transition area by adding points.
Using Xref Data in Surfaces

Externally referenced data in a surface imposes some usage limitations.

Using a standard AutoCAD Xref operation can be a convenient way to bring import a surface from another drawing. Doing this is great for visualization purposes, but some limitations apply to the use of editing commands with xref data. For example, you can use REFEDIT to select polylines within an xref drawing and temporarily add them to a surface as contours, breaklines, or boundaries. However, after you exit the REFEDIT mode, the link between the surface and the data becomes invalid, so it is lost after a surface rebuild operation and the surface does not react to changes in that data. To overcome this problem, the surface keeps a list of the polyline points instead of the polyline's object ID. As a result, the surface can be rebuilt, but it will always use the xref data exactly as it was when it was added to the surface.

For more information, see the AutoCAD help topic Edit Selected Objects in Referenced Drawings and Blocks.

Copying and Moving Surfaces

Observe a few guidelines to ensure correct surface location.

Surfaces in AutoCAD Civil 3D are defined by points, breaklines, gradings, and other components. These components appear in the surface definition as surface operations, and are listed on the Definition tab in the Surface Properties dialog box.

When a surface is copied in AutoCAD Civil 3D using a WBLOCK/INSERT operation, some of the defining entities for the surface are also copied, creating separate instances of these entities. For example, for a surface that is built by adding a point file and breaklines, the WBLOCK operation makes a copy of the breaklines but not the point file. During a subsequent INSERT operation, the copied objects (the surface and the breaklines in this instance) are automatically translated (moved) by AutoCAD to the new location. The new surface definition is updated to indicate that it is built from these translated entities, and then moved. If we rebuild the new surface at this point, it "jumps" from its current location to a different position. This double jump occurs because the copied defining entities for the new surface are already translated. When the translate operation for the surface (added by the copy operation) is executed, it makes the surface move again.

To avoid the double jump, the base point used for both WBLOCK and INSERT should be the same. The easiest way to do this is to use (0, 0, 0) for both operations.
When a surface is copied by selecting the surface and using the AutoCAD COPY command, the defining entities are not copied, and do not show up as separate instances in the definition of the new surface.

The manner in which these two different copying operations (WBLOCK/INSERT and COPY) are executed results in a significant difference in behavior: surfaces copied with the COPY command react to changes in the original data, but those copied using WBLOCK/INSERT do not. This difference exists because WBLOCK/INSERT makes new instances of the defining entities, while the COPY command retains the original objects in the surface definition.

Clipboard copy and paste operations (Ctrl-C, Ctrl-V) also follow the WBLOCK/INSERT logic. The copy operation actually runs a WBLOCK command in the background (writing the block to a temporary file, and placing the name of the file on the clipboard), while paste does what the INSERT operation would do. However, the base point location for WBLOCK in this case defaults to the lower left corner of the selected entities. So in order for the paste operation to avoid the double jump, you have to specify this location as the insertion point of the pasted entities. Since you do not know this computed location, the copy/paste operation typically results in a double jump, so it should not be used to copy a surface to the same or another drawing.

In summary, when you need to copy surface objects, and you want to include one or more defining objects in the current drawing (that AutoCAD will automatically translate), use (0,0,0) as the base point for the copy and paste operations. The following notes outline the recommended practices for common usage scenarios:

To copy a surface within the current drawing and have it react to changes in original data

■ Use the AutoCAD COPY command with only the surface selected.

To make a separate working copy of a surface in the same drawing (for example, to compare scenarios)

■ Make separate copies of the defining entities (in a different location, perhaps) and then build the new surface from these new entities.

To move a surface to another drawing (for example, to reduce clutter)

■ Use WBLOCK and INSERT to the other drawing with (0,0,0) as the base point. Specify the Delete from Drawing option for the WBLOCK command.
NOTE: The following practices are generally NOT recommended:

- Moving the defining entities of a surface. Some defining entities, such as point files, are not moved, which causes an incorrect surface definition.
- Moving a surface along with its defining data. This causes a double jump, as previously described.
- Using the All Points group as surface data. Any points you add to the drawing automatically become part of the All Points group and thus are included in the surface the next time you rebuild.

Working with Surface Points

Manage data files and the sequence of operations for greatest efficiency.

Referencing a Point File

Unless you need to edit points and point groups, add a point file reference to the surface definition rather than importing the point file into the drawing. This keeps the drawing smaller and easier to process. If your surface is composed from several point files, merge them into one large point file to improve performance.

Adding Breaklines First

If you add point data and breakline data (breaklines or contours) to a surface, add the breakline data first. The breaklines define specific surface features such as walls or ponds, so if they are present before points are added, the breaklines support the creation of a more accurate surface model.

Filtering Point Files

Ensure that your point file does not contain more points than required for your surface.

An excessive number of points can mean a coverage area that is too large, or a point density that is too high. In either case, it requires more processing time when the surface is saved or regenerated. To avoid this situation, filter the point file on import, limiting the number of points imported, or sampling a fraction of the points.
To filter a point file on import

1. In Toolspace, on the Settings tab, expand the Point ➤ Point File Formats collection.

2. Right-click the file type you want to import ➤ Properties.

3. In the Point File Format dialog box (figure 1), set the options on the lower right to limit the total number of points and set a sampling rate.

![Figure 1: Settings for point file filtering](image)

This type of filtering often makes sense when using LIDAR data, which contains points in a dense grid.

Working with LandXML Files

Use settings to minimize surface file size.

Before importing LandXML data to build a surface, check the LandXML settings for surface import, as shown in figure 2.

![Figure 2: LandXML surface import settings](image)
The option to create the source data (breaklines and contours) in the drawing adds 3D polylines. By turning off this option, you can make the surface file much smaller if the source data includes a lot of contours. This data is often not required for your design work with the surface.

**Working with DEM Files**

Understand some essential settings for digital elevation models (DEM).

If you have a choice of source data for your existing ground surfaces, create grid surfaces rather than TIN (triangulated irregular network) surfaces when possible. The difference in system memory requirements is significant for large surfaces. As a general rule, a grid surface, such as a DEM, requires about one-sixth (17%) of the memory space required by the same surface in TIN format.

**Exporting a DEM File**

AutoCAD Civil 3D enables you to export DEM files from a surface. At the time of export, you can expand the grid spacing to make the file smaller. Figure 3 shows the menu selection used to start the export process.

The Export Surface To DEM dialog box, shown in figure 4, is where you can set the grid spacing in the exported DEM file. A grid spacing of 2 covers a given area with one quarter the number of points required by a grid spacing of 1. Use a higher numeric setting here to create a DEM file that is smaller in size, and less detailed.

**Determining Grid Point Elevation**

An important export setting is the method for determining elevation at each point. You can choose to either sample the surface elevation at the grid point,
or compute the average elevation from surrounding points. The latter method (averaging) is more time consuming. For greater efficiency, use the surface sampling option, as shown in figure 4.

![Figure 4: Optimizing settings for an exported DEM file](image.png)

**Working with Contour Data**

Edit your input data to include only the essential regions.

Before you add contour polyline data to a surface, consider whether it includes any terrain that is not needed for design purposes. If so, you can use the AEC modify tools to crop unwanted portions of the contours. As shown in figure 5, these tools are available on the right-click menu when no objects are selected in the drawing.
Minimizing Flat Areas

Edit surface data for greater accuracy.

As surface triangles are created around contour data, erroneous flat triangles can appear in regions where contour lines follow tight curves, creating a condition where all three points of a triangle can be on the same contour. When you add contour data to a surface, it is important to understand how to use the settings for minimizing flat areas. Otherwise, the minimizing operation can run very slowly, and the resulting surface can be inaccurate.

When you add contours to a surface definition, the Add Contour Data dialog box includes default settings to minimize flat areas, as shown in figure 6.
If you add all your contour data in a single operation, use the three default settings shown in figure 6 to edit the contours and create a more accurate surface. AutoCAD Civil 3D uses these options to correct flat areas by checking the surrounding elevations, interpolating new points, and subdividing triangles.

If you add contour data in two or more batches, clear the check boxes for the initial batches, so that contours are not edited based on incomplete data. When you add the final batch of contour data, select the three check boxes to correct the contours based on the full data set.
This section explains how to use sites in AutoCAD Civil 3D to manage the dynamic interaction of design objects within a project.

Site Characteristics

The key points about a site in AutoCAD Civil 3D are as follows:

- Objects in each site collection interact topologically with each other.
- A site can contain alignments, feature lines, grading groups, and parcels.
- An object can occupy only one site at a time.
- Sites can overlap or occupy the same geographic region.
- You can move or copy objects from one site to another.
- Where two lines in the same site cross, they both acquire the same elevation. The line last drawn controls the elevation at these split points. This behavior affects feature lines, alignments, and parcel lot lines.

**NOTE** Feature line split point elevations can be controlled by changing the feature line style priority. For more information, see Feature Line Site Properties.

Multiple Sites

Using multiple sites provides a way to control object interactions within a single drawing. You can move or copy objects into the same site when you want them to interact, and move or copy them into separate sites when you want to isolate them.
Site Transparency

The fact that sites are transparent and always visible can be helpful in some situations, such as when you have soil-type parcels overlaid on a grading plan. In other situations, you might want to visibly mark the objects to indicate their site. For example, if you have two phases of a residential project in different sites, you can use the Site Properties dialog box to set the starting parcel number to 101 in one site, and 201 in the other. You can also use different object styles in each site.

Alignment Interaction

When you create alignments, you have the option of not assigning them to a site. Therefore you can keep your alignments from interacting with other site objects during the design period. After the alignment design is finished, you can move the alignments into the parcels’ site and work with the interactions between both object types.

If you use alignments in the design of utility networks, you may want to keep these alignments in a separate site from the parcels and the road alignments. Similarly, you may want to keep your overall grading plan in a separate site from the alignments and parcels.

For more information, see Site Interactions (page 130) in the Grading chapter.
Corridor Design

This section describes best practices for corridor design, including suggestions for the related alignment, assembly, profile, and section objects.

Corridors can be the most complex, data-rich objects in an AutoCAD Civil 3D engineering design. As you develop the design, structure the data for efficient processing by AutoCAD Civil 3D so that your work is not slowed down by events such as unnecessary rebuilding operations. The large amount of data in a corridor design must also be managed carefully so that it is most useful for those who review the design and construct it on the ground.

Alignments

When creating alignments, use a naming format that identifies the real-world reference for the alignment, such as “MapleSt - Edge_of_Pavement”. The default names such as “Alignment - 1” can get confusing as the design progresses and the number of alignments multiplies. Either type in the name of each alignment as you create it, or modify the alignment naming template to add any standard text to the name, such as project phase.

Some corridors can be designed entirely from a single centerline alignment, but most require additional alignments, such as the centerlines of intersecting roads. Create these other alignments before generating the corridor if you have the design information available. Other alignments such as gutter flow lines and curb returns, can be generated from the corridor design or added later in the process.

Alignment Design Strategies

If you are creating an alignment from a polyline, adapt your method to the nature of the polyline. The dialog box for creating an alignment in this way includes a check box for Add Curves Between Tangents, shown in figure 1.
If you select the Add Curves Between Tangents check box, you get an alignment with free curves inserted where two straight segments joined. These free curves are easy to edit, as they retain tangency at all times. If your input polyline includes arcs, these become fixed curves in the alignment, which do not retain tangency in editing. Leaving these as fixed curves is fine if you do not need to edit them. An alternative is to delete these fixed curve subentities and insert a free curve between the adjacent entities. Then if you need to edit the alignment, the free curve retains tangency.

Entity Types

If you are laying out alignments using the drafting tools, it can be overwhelming to see the wide range of line, curve, and spiral tools. To make the correct choice, it helps to understand the difference between fixed, floating, and free entities:

- **Fixed entities** are defined by specific points, with no topological relation to adjacent entities. In editing operations, fixed entities remain connected to adjacent entities, but can be moved out of tangency. This is the type of entity you get when you convert a polyline to an alignment.

- **Floating entities** are attached to an existing entity and remain tangent to it. Their endpoint, however is defined by other criteria, such as radius, length, a through point, or finding the best-fit path through a number of specified points.

- **Free entities** are always created between two existing entities, and always maintain tangency to them. Free entities are the most flexible in editing operations.

Once you determine which entity type best suits your design context, you can select the appropriate line, curve, spiral, or combination based on your available design data, such as whether you have a known through point, length, or radius.
**Superelevation**

If you are adding superelevation to any alignments, do so before creating the corridor. Also, the superelevation data is not dynamic, so it does not update if you grip-edit the alignment. Therefore, add the superelevation after the alignment design is stable, or be prepared to redo the superelevation if the alignment is modified.

**Assemblies**

Assemblies are a versatile component of corridor design, with many subassemblies and structural options to choose from. Understanding these options makes it easier to design corridors for a wide range of uses.

**Baseline Location**

An assembly baseline is typically located in one of two places, as shown in the following figures.

**Central Baseline**

Figure 2: Assembly for divided roadway

The assembly in figure 2 has a baseline in the center of a ditch between two roadways. This assembly can be used for a corridor designed symmetrically along a single central baseline. However, if you are designing a corridor section from the gutter flow line or another outside line, it usually makes more sense to place your baseline at that location. The best practice is to set your baseline along the primary alignment that controls the corridor’s location.
Outside Baseline

Figure 3: Assembly for curb return

Figure 3 shows a typical assembly for the design of a curb return in an intersection. The curb return is the curved region that joins the outside edges of two intersecting alignments. The assembly shows a single road lane with a gutter, curb, sidewalk, and standard daylight. The baseline is located where the edge of pavement meets the curb, as this is the alignment that controls the design. Another common location for a curb return baseline is the back edge of the curb.

Assembly Offsets

Use an assembly offset to associate a point on a subassembly with a secondary alignment. This is especially useful in a corridor region such as a knuckle or lane widening.

Figure 4: Assembly with offset

Figure 4 shows an assembly with an offset on the curb subassembly on one side of the roadway. This offset can be associated with an alignment that defines the outside road edge as it widens to accommodate a turn lane or off-ramp.
Drawing Management

**Corridor Model**

In a corridor model drawing, keep the drawing at a manageable size by using data references to bring in the alignment and profile from their source drawing, and the existing ground surface from its source drawing.

**Section Views**

Once the corridor is designed, create a separate drawing for the section views. In this drawing, use a data reference to bring in the alignment, and use an external reference (xref) to bring in the corridor drawing. The sections can extract the required corridor data from the xref.

**Profile Views**

If a drawing contains several profile views, these can add significant time to the file size and processing time. Several strategies are available to minimize these effects. Especially in the initial design phase of a project, keep each profile view as simple as possible, with minimal labels and data bands, and no clipped grids. As the design progresses, you can add more construction data to the display.

If you have profile views in the same drawing as a corridor, you can delete the views after you finish designing the layout profiles. The profile objects remain in the drawing for reference by the corridor, but the rebuilding operations are faster, and the drawing is a little smaller without the profile views. You can re-create the profile views as required in a production drawing, separate from the corridor.

For more information, see Simplify Profile and Section View Styles (page 30).

**Corridor Code Set Styles**

In the initial planning of your corridor, examine the assemblies you are using and identify the major points and links that will need special labels or display styles for higher visibility in the design. For example, you may need to show ditch side slopes or elevations along the gutter flow line. For purposes of three-dimensional display, you may want to color the paved surfaces black and the ditches green. These controls are all available in code set styles. You can find Code Set Styles in Toolspace, on the Settings tab, by expanding General collection ➤ Multipurpose Styles.
Corridor Regions

In the initial design stages, divide each corridor into multiple regions. Create a separate region wherever the assembly changes, such as for lane widening or intersections. As the design gets more detailed, you can turn off regions you are not working in and experience faster rebuilds. In each region, set the assembly frequency and the section swath width to avoid loading the design with unnecessary data. For example, assemblies can be widely spaced along a straight roadway across flat terrain, and spaced more closely in regions with a lot of change.

Section Swath Width

Section swath width should be set to a value not much wider than the maximum corridor width between the daylight lines on each side. Avoid a swath width that takes in excessive amounts of the existing ground surface beyond the corridor.

Creating Corridor Regions

Instead of creating one region for a long corridor, divide the corridor into multiple, smaller regions. For example, on a 5,000 meter corridor, create five regions, each of which is about 1,000 meters long. This reduces the processing load when rebuilding the corridor.

Setting Corridor Region Targets

Set region targets after creating the regions. For example, when creating regions, leave the targets set to “None” and proceed with creating the regions. After the regions are created, set the targets on the regions. This reduces the processing load because processing the assembly insertion points (during region creation), and processing the setting of the assembly targets, are two separate operations instead of one.

Hiding Corridor Regions

Hide unneeded regions when editing corridors. For example, when editing a corridor that contains multiple regions, hide the regions that you are not editing. This results in faster system response time while editing a corridor region.
Large Corridor Models

Installing and using AutoCAD Civil 3D on a 64-bit version operating system provides optimal system response time when working with large data sets, including large, complex corridor models.
Parcels

This section describes best practices for parcel creation, editing, and annotation, particularly in the context of subdivision design.

Creating Parcels

This section describes parcel creation best practices.

How Parcels are Defined

Regardless of how they are created, parcels are defined by closed polylines. All lot line intersections must be closed to create correct topology for calculations of linear dimensions and parcel areas. Parcels are defined by their boundary lines, and not their area, the space inside the boundary lines. Adjoining parcels share lot lines, so if a lot line is deleted, the two previously existing parcels become a single parcel.

Cleaning Up Drawing Errors

Before you convert AutoCAD objects to parcels, ensure that the objects do not contain drawing errors that will adversely affect the parcel tools. Use the AutoCAD Map 3D cleanup tools to check the objects for errors. For more information, see Maintaining Clean Drawings (page 31) in the Templates, Styles, and Drawings chapter.
Creating an Enclosed Parcel

If you create a parcel from a closed area, such as a polygon that is fully enclosed in a parcel, the smaller area will be subtracted from the total area of the larger parcel. You end up with two parcels, with one being an island parcel inside of the other as shown in figure 1.

Figure 1: Enclosed parcel subtracts area from larger parcel
Right of Way (ROW) Creation

Right of way parcels can be automatically generated for parcels located along alignments. Remember the following when creating ROW parcels:

- One ROW parcel is created for each selected parcel adjacent to the alignment. For example, if you choose two parcels during ROW creation, one on each side of an alignment, two separate ROW parcels are created, not one complete parcel. These parcels can be combined using the Parcel Union tool on the Parcel Layout Tools toolbar.

- You do not have to choose parcels on both sides of the alignment to generate ROW parcels. However, if you only pick a parcel on one side, only the ROW parcel on that side of the alignment will be created.

- If you select a parcel that is adjacent to more than one alignment, the offset value set in the dialog box will be used on all adjacent alignments.

- The alignment must be in the site for ROW parcels to be generated.

Parcel Topology and Sites

Parcel topology is controlled by using sites. Drawings may have multiple sites and sites may contain multiple parcels. Each site represents a different set of relationships (topology) between objects. Parcels must exist within a site and they interact with other objects contained in the site, such as feature lines and alignments.

Any parcel segment drawn through an existing parcel will subdivide the parcel. To prevent this subdivision, you can create new parcels in a different site so that they will not be included in the same topology as the original parcels. Remember the following points when working with parcels and sites:

- Each site has a site parcel that represents the extents of all objects within the site.

- All parcels within a site are dynamically related to each other. However, parcels in one site are not related to parcels in a different site.

- While parcels within a site cannot overlap, sites can overlap, which in turn enables you to work with overlapping parcels. For example, property parcels overlapping soil mapping parcels.

- Parcels can be moved to a different site, but the original relationship to the other parcels in the original site is lost.
- Objects within a site do not have to touch each other.
- You can see a complete list of sites and the parcels within them on the Prospector tab of Toolspace.
- Use the Copy to Site and Move to Site commands to rearrange where objects are located and to prevent unwanted interaction.
- Certain site properties such as the site parcel style are specific to the Parcels collection within a site. To edit these properties, right-click the Parcels collection under the named site collection.

### Parcel Interaction with Alignments

#### Default Alignment Layout

When you create an alignment with the Create Alignment - Layout or Create Alignment - From Polyline dialog boxes, the default is to create the alignment with no specified site <None> as shown in figure 2.

![Create Alignment - Layout dialog box](image)

**Figure 2: Place alignment on <None> site**

This setting is recommended so that your alignments do not interact with parcels when they are created. If at a later time you would like them to interact with parcels, feature lines, or other alignments, you can move or copy the alignment to a site.
Parcel Interaction with Feature Lines

When lot lines and feature lines in the same site cross, they create a split point. This point acquires the elevation of the line last edited—commonly known as the “last one wins” rule. To prevent this interaction, create separate sites for parcels and for the feature lines in a grading plan.

Feature Line Editing Commands

Use the feature line editing commands to edit parcel geometry and parcel elevations. You can access these commands by selecting a parcel and then selecting either the Edit Geometry or Edit Elevations panels to access the commands.

Parcel Sizing Parameters

AutoCAD Civil 3D uses minimum frontage, minimum area, minimum width, and minimum depth criteria when laying out parcels with the Parcel Layout Tools parcel creation commands.

By setting the parcel sizing parameters, the program can assist you to lay out new parcels according to these particular constraints. After you define the frontage start and end points, preview graphics display the proposed solution based on the parcel sizing parameter values.

Upon completion of the command and if there is no solution, you are prompted to adjust the parcel sizing parameters. Each time the Parcel Layout Tools parcel sizing parameters are modified, the preview is updated, and you are prompted to accept the results.

The following parcel sizing parameters are used by all the parcel creation and editing commands. See Create Parcels - Layout Dialog Box for more information.

- Minimum area
- Minimum frontage
- Frontage offset
- Minimum width
- Minimum depth
- Maximum depth
The following values are optional and only used for specific layout criteria.

- Use minimum frontage at offset
- Use maximum depth

**Canceling Parcel Creation Commands**

To cancel a parcel creation command while using the Parcels Layout Tools toolbar, you can press ESC, but be sure to watch the command line. If you press ESC too many times, the toolbar closes. If you simply hit ESC until the command line indicates you should select from the layout tools, you will have successfully canceled the command while keeping the toolbar open. This is also true of other AutoCAD Civil 3D toolbars. You can also press ESC to change the Parcel settings without having to close and reopen the toolbar.

**Parcel Creation Automatic Mode**

You can use the Parcel Layout Tools to automatically or semi-automatically divide existing parcels. Automatic mode allows you to use the parcel layout tools to automatically layout and preview multiple new parcels that will occupy the available area. If you turn off Automatic Mode, the layout tools lay out proposed new parcels one at a time.

**Automatic Mode**

Use the Parcel Layout Tools Automatic Mode option as shown in figure 3 to quickly lay out multiple new parcels. Automatic mode works best with symmetrical areas and regions with uniform shapes. For areas with irregular shapes or tight inside corners, use the manual layout mode.
When Automatic Mode is turned on, after you specify the frontage start and end points, the preview graphics display the proposed new parcels, based on the specified criteria. If you accept the proposed solution, such as the example in figure 4, the parcels are created simultaneously.

**NOTE** When in Automatic mode, the Redistribute Remainder option is enabled.
You can size the parcel by specifying a minimum frontage and a minimum area.

You can use the additional parameters, such as frontage offset, minimum width and depth for even greater precision when you initially lay out the parcels. The parcel sizing parameters allow for a continuous workflow. If you reject a proposed solution, you can simply adjust the parameters and the preview graphics update dynamically.

**NOTE** When you have a large irregularly shaped parcel to subdivide, it can create varying parcel sizes depending on the creation method used (by angle, by direction, by line). When working with irregular shapes, it is recommended that you create back lot lines, and divide an area into bands, blocks, or pieces where the tool will work well.

**Semi-Automatic Parcel Layout**

You can use the parcel layout tools to semi-automatically lay out parcels. To do this, turn off Automatic Mode when using the parcel sizing commands so that the creation tools lay out parcels one at a time. When Automatic Mode
is turned off, the preview graphics only display the immediate parcel being solved. Even though automatic mode is turned off, the parcel tools draft the proposed new parcel for you, based on the specified criteria as shown in figure 5.

When you accept a proposed solution when Automatic Mode is off, the preview graphics display the next proposed new parcel as shown in figure 6. You have the option to accept solutions one at a time.
Parcel Layout Scenarios

The Parcel Layout Tools support different methods of laying out parcels. In addition to the area and frontage parameters, you can specify minimum frontage offset constraints or the use of minimum width and depth constraints. The following sections describe these methods. Experiment with these methods to see what works best for your design needs.

Layout Parcel by Minimum Frontage at an Offset

Now you can use the optional minimum frontage at offset option when creating parcels.

To layout parcels using minimum frontage at an offset

1. Click Home tab ➤ Create Design panel ➤ Parcel drop-down ➤ Parcel Creation Tools to open the Parcel Layout Tools.
2. Enter the values for Minimum Area, Minimum Frontage, and Frontage Offset.
3 Set Use Minimum Frontage At Offset to yes.

4 Choose a creation tool.

5 In the Create Parcels - Layout dialog box, select the desired site, style, layers, and label styles. Click OK.

6 Select the parcel area selection label of the parcel that you would like to subdivide. Or you can pick a point within the parcel.

7 Select start and end points of the frontage line. As you draw along the frontage, a preview line is displayed.

8 Depending on the tool you selected (Slide Line, Swing Line, and so on) provide the information requested at the Command prompt.

9 Preview graphics display if the proposed solution is correct. The green dashed line represents the frontage offset as shown in figure 8. Accept the resulting solution or enter No to end the command so that you can adjust the sizing parameters.
Figure 8: Preview of proposed solution and frontage offset line
Lay Out Parcel by Minimum Depth and Minimum Width

Now you can lay out a parcel by specifying a minimum area, a minimum frontage, a minimum depth, and minimum width at the minimum depth.

To layout parcels using minimum width and minimum depth

1. Click Home tab ➤ Create Design panel ➤ Parcel drop-down ➤ Parcel Creation Tools to open the Parcel Layout Tools.
2. Enter the values for Minimum Area, Minimum Frontage, Frontage Offset, Minimum Width, Minimum Depth, and Maximum Depth.
3. Set Use Maximum Depth to Yes.
4. Choose a creation tool.

Figure 9: The new parcel is created
5 In the Create Parcels - Layout dialog box, select the desired site, style, layers, and label styles. Click OK.

6 Pick a point inside the parcel that you would like to subdivide.

7 Select start and end points of the frontage line. As you draw along the frontage, a temporary line is displayed.

8 Depending on the tool you selected (Slide Line, Swing Line, and so on) provide the information requested at the Command prompt.

9 Preview graphics display if the proposed solution is correct as shown in figure 10. Accept the resulting solution or enter No to end the command so that you can adjust the sizing parameters. Figure 10 displays preview graphics with Automatic mode turned on.

Figure 10: Proposed solution using maximum depth criteria
If you accept the proposed solution, the new parcels are created as shown in figure 11.

Figure 11: The new parcels are created

Marissa Jenkinson, a Sales Applications Engineer for CADD Microsystems, Inc., (http://www.caddmicro.com) based in Alexandria, Virginia, U.S.A., has contributed content to this parcel creation section as well as to the parcel editing best practice information.

Editing Parcels

This section describes best practices when editing or altering parcel data.
**Editing Lot Lines**

Attached lot lines are created with the slide line, and swing line precise sizing tools available on the Parcel Layout Tools toolbar. You cannot slide or swing edit regular lot lines, because these commands only work with attached lot lines. When you grip an attached lot line, note that it has a single triangle grip at one end and can be grip edited to slide it along the lot line it is attached to. When working with attached lot lines, edit single lines one at a time.

The feature line editing commands that insert or edit elevation points work with attached lot lines. Feature line commands that edit the geometry such as Reverse, Insert PI, and so on, do not work with attached lot lines. For more information, see .

**Grip Editing**

If you grip edit a parcel line and drag it past the Area Selection Label centroid, the parcel regenerates and may be assigned a new number and a different style. Track where the centroid is while grip editing. It is recommended that you complete grip editing and configuration of parcel geometry as much as possible before you add labels.

**Adding a Boundary**

You can add a boundary around a selected number of parcels. The boundary is represented by a 2D polyline.

To *create a boundary around a selected number of parcels*

1. Enter `LineworkShrinkwrap` at the command line.

2. Select the parcels that you want to use as a boundary and press Enter.
   This command draws a polyline around touching objects. If your selection includes parcels that are not touching, the boundary is drawn around each individual parcel.

**Deleting Parcels**

To delete a parcel, you must delete the individual parcel segments. You cannot delete a parcel by selecting its area selection label and pressing the Delete key. Also note that if you delete a segment line, the parcel as a whole no longer exists even though three of the perimeter lines still exist.
NOTE If a parcel segment is on a locked layer, you are not able to delete the segment. You must unlock the layer, and then you can delete the segment.

**Offsetting Parcels**

Parcels and parcel segments can be offset using the standard AutoCAD Offset command. To offset an entire parcel, select the area label when asked to pick objects. To offset just one segment of a parcel, select the segment entity when asked to pick objects. You can also offset your site parcel to see its extents and the objects it contains.

**To offset a site parcel**

1. At the command line, enter `offset`.
2. Enter a small distance (for example, 2 feet).
3. Choose the Site Parcel Area Label as the object to offset.
   The outline of the site parcel is displayed.

**Updating ROW Parcels**

When you edit an alignment in AutoCAD Civil 3D, the ROW parcels are not automatically adjusted. This means that the ROW parcels are incorrect after the change, and all other adjacent parcels are outdated as well. There is a quick way to adjust these parcels.

**To update ROW parcels**

1. Once the alignment has been edited, offset it to each side to generate a construction line representing where the ROW lines should be.
2. Grip edit the ROW parcel segments using OSNAPs to match precisely the new vertices of the construction line.
3. Edit any curve segment parameters using the sub-entity editor tools, which are accessed on the Parcel Layout Tools toolbar.

**Labeling Parcels**

This section describes best practices when labeling parcels.
When to Add Labels

It is a good general practice to create and edit your geometry before creating labels. This applies to parcels as well.

Parcel Xref Data

When you externally reference parcel data, you can add labels to them in the current drawing. You can label parcel xrefs in the same way that you would label any object. It is recommended that you do not apply labels in a source drawing that you will be externally referencing because these labels are not editable. You should insert xrefs and then label them in the current drawing. If you want to add parcel tables, you must first convert the labels to tags.

For managing projects with parcel data, use parcel external references. Vault does not currently support parcel data so you must use parcel xrefs to input source data into your current drawing.

Parcel Area Selection Label

The parcel area selection label is an embedded object that cannot be deleted, as it is used to select a parcel. The parcel area selection label is distinct from other parcel area labels. The area selection label and other parcel labels are all supported by the AutoCAD Properties palette. To edit the parcel area selection label, right-click and select Edit Area Selection Label Style as shown in figure 12.
Quickly Editing with the Style Selection Dialog Box

To quickly edit a parcel line segment or other label object, except for parcel area selection labels, right-click and select Edit Label Style.

In the Object (Parcel Line Label) Style dialog box, you can perform the following actions:

- Create a new style
- Copy the existing style
- Create a child style from the existing style
- Edit the current style properties with the Label Style Composer
Editing Parcel Line Segment Labels

To save time, you should bulk edit multiple parcel label properties with the AutoCAD Properties palette.

To bulk edit parcel segment labels

1. Click multiple segment labels in the drawing to select them. The labels are highlighted.

2. Right-click anywhere in the drawing and select Label Properties or Properties.

3. In the Properties palette, select the Line Label Style pull-down menu as shown in figure 13.
   You can choose from all existing parcel segment labels.

**NOTE** The General Line Label Styles are also available for annotating parcels.
The General Line Label Style can be used with parcels as well as feature lines and alignments, and can be selected from the Add Labels panel on the Annotate tab.

The Properties palette also provides access to the Label Style Composer through the Edit Current Style option. This allows for more uninterrupted style property editing because you do not have to navigate to the Toolspace Settings tab.

From the styles pull-down menu in the Properties palette, select Create/Edit (as shown in figure 13) to access the Object (Parcel Line Label) Style dialog box as shown in figure 14.
Labeling Parcel External References (Xrefs)

The following exercise is presented to demonstrate the best way to insert and then annotate parcel data. There are three parts to the operation:

- Insert an xref of the parcel drawing into a drawing that contains AutoCAD objects.
- Label the lot lines.
- Edit the resulting labels.
Open the files: C:\Program Files\Autodesk\AutoCAD Civil 3D <version>\Help\Civil Best Practices Guide\source.dwg and C:\Program Files\Autodesk\AutoCAD Civil 3D <version>\Help\Civil Best Practices Guide\current.dwg

1 Maximize current.dwg, and click Insert Tab ➤ Reference panel ➤ Attach . In the Select Reference File dialog box, navigate to source.dwg, select it and click Open.

2 In the External Reference dialog box, set Insertion Point to 0,0,0, Scale to 1,1,1, and Rotation Angle to 0. It is recommended that you set the Path Type to Relative Path.

![Figure 15: Required settings for Xref labeling](image)

3 Click OK.

4 Add labels as you would for regular data. Click Annotate tab ➤ Labels panel ➤ Line And Curve ➤ Add Multiple Segment Line/Curve Label . Label all of the lines and curves that comprise LOT7 and LOT16, which are xref data. The labeling commands work as they do for regular objects.
5 Select and right-click the xref parcels and observe the xref commands that are available.

**NOTE** The xref data is highlighted with dashed lines when selected. The xref commands affect the corresponding labels in various ways. If you detach or bind the xref, the label is deleted and must be recreated.

6 Right-click a parcel that exists in the current drawing and note the context menu as shown in figure 16.

![Figure 16: Xref object context menu](image-url)
NOTE When you label xrefs, designate them as such to avoid confusion. With the Text Component Editor, add a convention to the label text for identification. This is an easy way to differentiate xref and native object data.

Parcel Spanning Labels

AutoCAD Civil 3D provides parcel line and curve anchor points for the creation of useful visual cues when annotating parcels. In previous releases, workarounds were used to create crow's feet to indicate the start and end points of lot lines. These extra steps are no longer necessary.

The Iron Node point label style can be used to indicate where parcel lot lines meet. In the Add Labels dialog box, note the Span label style as well as the Iron Pipe label style.
Figure 17: Parcel span label with crow's feet
Table Tag Renumbering

In AutoCAD Civil 3D, table tag control is maintained through the Toolspace Settings tab. While in Master View, right-click the drawing name and select Table Tag Numbering.

![Figure 18: Table tag numbering option](image)

When creating tags, duplicates are not created by default, even if the starting number for creation is set to a duplicate number. You can create duplicates by using the renumber tag command.

![Figure 19: Dialog box for table tag control](image)
Creating Parcel Tables

In AutoCAD Civil 3D, you can create tables for xref parcel data and for parcel data in the current drawing. Click Annotate tab ➤ Labels & Tables panel ➤ Add Tables menu ➤ Line And Curve ➤ Add Line Tables.

When using the Create Table dialog box, use the No Tags Selected check box option to go into the drawing and select numerous labels that you want to convert to tags for table inclusion.
The surface modeling tools in AutoCAD Civil 3D software include generic ones, such as points and breaklines, as well as purpose-built site grading tools for grading with feature lines and projected slopes. Understanding the strengths and limitations of each tool—and learning how to use them together—is a major part of learning best practices in grading.

Feature Line Grading Overview
Create a set of feature lines to define the graded region as surface breaklines, and then adjust the elevation of key points to control the shape of the surface. Use this grading method for wide, fairly flat areas, such as parking lots or building pads. It is also well suited to areas with rapidly changing elevations or slopes, where walls would normally be required to grade successfully. You can manually add or remove feature lines, and adjust their location in three dimensions, to achieve precise slope design. Using this process, you can control water drainage, or clean up difficult geometry in areas such as the intersection of two or more slopes.

Slope Projection Grading Overview
Project a slope from a feature line to an intersection with a surface, or to a specified distance, elevation, or elevation difference. Use this grading method to calculate proposed feature lines based on some criteria. A major benefit of projection grading is that the resulting grading objects remain true to the original criteria if the base feature line is edited. Additionally, you can edit the criteria, and the grading model reflects the change. This method works best when you need to maintain relationships between feature lines.

This section explains some techniques for using each of these tools to get optimal results from AutoCAD Civil 3D.

Feature Line Grading
Feature lines are like advanced 3D polylines, with the following differences:
- They support true geometric arcs.
They interact with each other. Where two feature lines intersect at a point, editing the elevation of the point edits the elevation of both feature lines.

They have much better editing support than 3D polylines.

Site Interactions

A site is a collection of objects that are topologically related. The object types that can be included in a site are feature lines, parcel lot lines, and alignments. A key point to remember is that when objects in the same site intersect, they acquire the same elevation at the crossing point, similar to crossing breaklines in a surface. You can create overlapping objects that do not interact this way, by simply assigning them to different sites. The following sections describe some of the interaction of objects within a site.

Feature Lines

Use multiple sites to manage grading feature lines in distinct groups. The Move to Site and Copy to Site commands are helpful in this process. For example, you can copy feature lines to another site, then lower their elevation to create a subsurface.

Lot Lines

Traditionally, lot lines are thought of as 2D representations of parcels. However, in AutoCAD Civil 3D, lot lines can also have elevations and can be used in building a grading model. Feature line editing commands are used to assign elevations, including elevations at intermediate points. Lot lines interact with feature lines, sharing elevations at common points. They can also be added to surfaces as breaklines. When you display the lot lines, you can use the elevations of the objects or you can flatten the elevations to a specific elevation. This option is available in Site Properties.

It is not always desirable to use lot lines directly for grading work. Inserting elevation points, or intersecting feature lines with lot lines creates break points in the lot line geometry, which affects labels. A lot line crossed by a feature line is split into two segments with separate labels. On a small site, you could use a mix of lot lines and feature lines in your grading site, ignoring the parcels that are created.
Preventing Lot Line Interaction

Provide greater clarity in a grading design by preventing the interaction of lot lines with feature lines, using separate sites for parcel geometry and grading features. One approach is to replace the lot lines with feature lines in the grading site. There are several methods for doing this:

■ If you create the lot lines from AutoCAD entities, use the same entities to create feature lines in the grading site.

■ Copy the lot lines to the grading site, and then explode these lot lines, turning them into AutoCAD entities. Then, use grading tools to convert some or all of the lot lines into feature lines.

■ For a small site, trace the lot lines with AutoCAD entities to convert to feature lines, or use the Draw Feature Line command.

Alignments

Alignments do not have elevations assigned to them directly, but obtain elevations from a profile model. As with lot lines, alignments interact with feature lines in the same site. The most common problem is the result of creating a split point where a feature line crosses an alignment, because both objects acquire the same elevation at that point. Split points are explained more fully in the next section, Point Types and Elevation Control.

It is recommended that when you create alignments, do not assign them to a site until the design period is complete. This prevents interaction between alignments, feature lines, and parcels. In AutoCAD Civil 3D, the default alignment creation options provide this behavior.

Point Types and Elevation Control

The primary point that defines the geometry of the feature lines is called a point of intersection (PI). It is represented by a triangle symbol in the Elevation Editor, or when a feature line editing command is used. The PI appears as a standard square grip when grip editing a feature line.

You can insert elevation points along a feature line to define grade breaks. The elevation points do not break the horizontal geometry of the feature line. They are represented by the circle symbol for both the feature line commands and grip editing. When grip editing, you can drag an elevation point to a different position along the feature line.
When two feature lines cross at a location where neither one has a PI point, a split point is created. This is displayed in the editor with a white triangle, rather than a green PI triangle.

In figure 1, the Elevation Editor shows the elevations for the square feature lines, including two split points where these lines cross feature lines BC and CD. In the Elevation Editor, the point symbol in the first column includes a plus sign (+) at any point that intersects with another feature line.

### Split Point Elevation Control

When feature lines within the same site cross each other and create a split point, that point acquires the elevation of the feature line that was last edited, which is commonly known as the “last one wins” rule. If the other feature line has a different elevation, it gets a grade break at the crossing point.

If a site contains feature lines of different styles, you can specify a priority level for each style for the purpose of controlling split point elevations. For more information, see Feature Line Site Properties in the Grading chapter of the User’s Guide.
There is not an actual point at split points, so you cannot directly edit the elevation. When you edit one of the feature lines, its grade runs straight through the intersection, forcing the other feature line to break at the split point. If you create a feature line from AutoCAD entities, without assigning elevations, the new line has a default elevation of zero (0). To edit the elevation of a split point directly, or have better control over the point, use the Insert PI command to create a permanent point at that location on one of the feature lines.

**Feature Line Break/Trim/Extend**

While the AutoCAD Extend command works with feature lines, they cannot be edited with AutoCAD Break or Trim commands because feature lines are too complex. To overcome this problem, dedicated feature line Break and Trim commands have been added to the feature line Edit Geometry Panel, as shown in figure 2. The break and trim commands provide precise control over feature line editing operations.

![Feature line editing commands](image)

*Figure 2: Feature line editing commands*

**Feature Line Move**

When editing feature line elevations, the best practice is to use the grading feature line tools, such as the Elevation Editor, which provides reliable controls for incrementally raising or lowering an entire line or specified points. AutoCAD commands, such as MOVE and OSNAP, can give undesirable results unless used carefully. For example, an accidental OSNAP to an object at elevation 0 will set the elevation to 0. However, you can use the AutoCAD MOVE command to move a feature line horizontally.

**Feature Line Smoothing**

You can smooth a feature line created from a tessellated (segmented) polyline to a series of curves or a true geometric arc, as shown in figure 3.
Polyline 1 on the left is smoothed in two different ways in the arcs on the right, using feature line editing commands, as shown in figure 2.

Line 2 was created with the Smooth command. When selected, it retains the four grips of a polyline. This type of line always retains tangency to the adjoining lines, and it can be adjusted to form a complex set of arcs, such as for creating an aesthetically pleasing landscape design. If you label this line, you can obtain the precise arc parameters for layout on the ground.

Line 3 was created using the Fit Curve command. In this case, the three segments have been converted to a single arc. If you grip edit this arc, it does not always retain tangency with the adjoining lines. A single arc can be easier to lay out and usually results in a simpler grading design.

When creating gradings from corridor feature lines, you can use the Corridor command CreateGradingFeatureLine. As shown in figure 4, you can configure the Feature Line Creation Options to smooth the feature line when it is exported, and to create a dynamic link between the corridor and the feature line. Smoothing the feature line replaces tessellated line segments with arcs, and creating a dynamic link ensures that the feature line is updated with any changes to the corridor.
Duplicate and Crossing Feature Lines

Feature lines in the same site can only have one elevation at a crossing point. If two feature lines approach within a tolerance distance of 0.0001, the points collapse to a single point. If feature lines are so close that they nearly overlap, yet do not collapse, the topology model becomes much more difficult to represent. In these cases the model creates very small “sliver” enclosed areas, analogous to sliver triangles in a surface TIN model.

In most cases, sliver areas are not a problem, but excessive overlapping can be difficult to model in the topology and can extend the surface processing time. In particular, this can happen when you have multiple feature lines overlapping with slightly different geometry. Also, arcs tend to have more problems than lines when resolving overlapping geometry.

Keep these interactions in mind when creating feature lines for a grading plan. In general, if you try to represent duplicate feature lines, it is a good practice to put them in separate sites. Otherwise, visually inspect the feature lines within a site and remove any that are nearly tangent and not required. Remember these practices, and use them also when creating lot lines and alignments.

**NOTE** Use the FindSiteOverlaps command to identify overlapping site objects. For more information, see Finding and Resolving Overlapping Site Objects.
Feature Line Labels

Feature lines labels use the general multipurpose line and curve label styles. The AutoCAD Civil 3D NCS drawing templates contain several useful styles, including Grade Only and Slope Only.

Setting Downhill Arrows

The default Grade Only label style displays the grade using a direction arrow that points in the forward direction of the feature line.

Figure 5: Default display of a Grade Only label on a feature line

Use an expression to configure the direction arrows in this label style to point in the downhill grade direction, which may be more useful. To do this, edit the Arrow component of the Grade Only style, as shown in figure 6.
Figure 6: Configuring Grade Check arrows in Grade Only label style

To set downhill grade arrows

1. In Toolspace, on the Settings tab, expand the General ➤ Label Styles ➤ Line collection.
2. Right-click Grade Only ➤ Edit.
3. In the Label Style Composer dialog box, on the Layout tab, select the Arrow component.
4. In the Direction Arrow section, click the value for Rotation Angle and select Grade Check.
5. Click OK to apply the change.

Projection Grading

You construct a grading projection from feature lines. As shown in figure 7, the controlling feature line to which a grading is attached is called the footprint. You can edit this feature using the feature line commands. The grading projection creates another line at the outer edge, known as a daylight.
line. Depending on the grading criteria, the daylight can be at a specified elevation, distance, or where the grading meets the existing surface. The daylight line is controlled by the grading object and cannot be edited directly.

![Figure 7: Parts of a grading object, shown on a 3D solid](image)

Projection lines connect the footprint to the daylight line at key design points, such as the start and end of transitions. These projection lines are created with non-editable feature lines. Grading styles have a 3D solid display component that shades the surface and displays automatically in a 3D view. This can be used to view the grading without creating a terrain model.

**How Projection Grading Works**

Grading algorithms used in some commercial civil engineering products employ a simple method of ray projection. A ray is simply projected from the footprint at the given criteria to find the intersection with the surface. This method does not fully resolve situations where the grading intersects itself in 3D, such as in a tight inside corner, or where the grading is projecting past the radius of the footprint, as shown in figure 8.
Figure 8: Projecting past the radius of a footprint

Figure 8 shows an example where the footprint has a rounded corner with a radius of 50 feet. Gradings are projected out 100 feet to the surface, and the gradings along two adjacent sides intersect far from the corner. The region of intersection can be quite complicated if the two segments have different footprint elevations or slope projections, resulting in ambiguous elevations where they meet.

**Boundary Representation**

AutoCAD Civil 3D slope grading uses a technique known as boundary representation, or b-Rep modeling. For each segment of the footprint, a bounded cone, plane, or spline region is created to match the grading criteria for that segment. These pieces are intersected against each other, and the resulting pieces are joined together in order to create a grading with real 3D intelligence.
Figure 9 shows exactly how the cone on the outside corner of a pond intersects with the surface. Notice that you cannot draw a straight projection line from the footprint to the part of the grading that flows along the valley in the lower left. A simple ray projection algorithm would not generate this part of the solution, because it would find only the first ray intersection with the surface, at a higher elevation. By showing accurate results of the grading criteria, AutoCAD Civil 3D makes it easier for engineers to see important details and explore realistic design options. For example, in this case we can see that a retaining wall could prevent the grading from flowing along the valley, and we could revise the design to include such a wall.

Finding a good solution becomes more difficult if the grading segments do not intersect each other fully. AutoCAD Civil 3D uses straightening and averaging algorithms to handle these and other problem spots in a second computing pass. While the 2D daylight is reasonably clear in most cases, finding the complete 3D edited solution can be much more complicated. Another complicating factor is the limited precision with which computers can calculate intersections. For these reasons, short segments and shallow angles can also be problematic.

**Case Study: Two Intersecting Gradings**

We can learn more about how AutoCAD Civil 3D creates gradings by looking at some examples of grading intersection. Figure 10 shows the top view of two overlapping gradings. The segment on the left has a grade of 0%, and the one on the right has a steep grade of 100% with a cross-slope of 2:1.
Figure 11 shows a side view of the gradings, which reveals that they have only a single point of intersection. This results in a “chasing grade” situation between the two segments, without a mathematical intersection line between the two patches, except for the degenerate intersection at the corner point.

This example uses exaggerated slopes and grades to show the problem more clearly, but a similar problem can easily happen any time the slope along the footprint exceeds the cross slope. If two gradings do not intersect, AutoCAD...
Civil 3D handles the problem by averaging the slopes and elevations in the intersection zone. This effectively transitions the cross slope in most cases, as shown in figure 12.

![Figure 12: Calculated transition for two intersecting gradings](image)

This situation is very common in real-world grading scenarios. In particular, it occurs when grading to the inside of a footprint where elevations of the footprint vary. Similar grading intersection problems can also occur when transitioning around inside corners.

**Case Study: Three Intersecting Gradings**

When more than two patches overlap each other from the top view, but do not intersect completely in 3D, finding a solution is increasingly complex as shown in figure 13.

![Figure 13: Plan view of three intersecting gradings](image)
If you look closely from the side, you can see that two of the patches do not intersect at all, and the other intersections are incomplete.

Figure 14: Side views of three intersecting gradings

In this case, AutoCAD Civil 3D can resolve the conflict through a process of elevation averaging, but as the ambiguous region becomes more complex, the resolution is more difficult. Figure 15 shows the cleaned-up 3D view of the three intersecting gradings.

Figure 15: Calculated transition for three intersecting gradings
Preparing the Footprint

The previous section demonstrated how AutoCAD Civil 3D models complex geometries. These concepts imply, and illustrate several best practices for preparing a grading footprint. For example, you can use feature line editing tools in AutoCAD Civil 3D to clean up and simplify feature lines.

You can use some of the following best practices:

- Use the Elevation Editor to verify the elevations along feature lines. Look for locations where an elevation may unintentionally drop to zero (0), such as at a split point.

- Use the Weed command (WeedFeatures) to remove unnecessary points and simplify grading geometry where possible. This operation can significantly improve the results where two or more gradings intersect.

- Use the Fit Curve command (FitCurveFeature) to replace tessellated segments with an arc. This operation creates a smoothly curved grading face, rather than many short straight segments. Tessellated segments are common with feature lines created from 3D polylines that do not have arc support, such as those created with the Land Desktop grading commands.

Removing Unnecessary Points

Figure 16 shows the dialog box for configuring the weeding operation. You can specify the weeding factors to apply, adjust the numeric values, and preview the results before committing. Click the Help button on this dialog box to see the Help topic for weeding and learn how to use these controls for best results.
Replace Tessellated Segments

The grading in figure 17 on the left is graded to the inside of a curve that has been tessellated by line segments. The grading on the right is graded from a true arc. The edited shape of the true arc is a more realistic grading.

Figure 17: Grading a segmented curve versus a true arc

You can use the Smooth command to convert a tessellated feature line to a true arc, that is similar to the polyline fit curve.

Grading to Targets

This section presents some best practices for different target types.
Grading to a Surface or Absolute Elevation

Grading to an absolute elevation is treated as though you were grading to a flat surface at that elevation. If you are unsure of a grading’s ability to intersect with the surface, start with a steeper slope, then edit to a flatter slope.

Grading to Distance, Relative Elevation, or Stepped Offset

Grading design often makes use of offset feature lines for features such as curbs and ditches. You can create these in two general ways, depending on whether you want the secondary line to be dependent or independent of the footprint:

- Grading to a distance or to a relative elevation creates a dependent parallel line linked to the footprint. In this case, editing the footprint also updates the offset line.
- Using the Stepped Offset command creates an independent parallel line that you can edit separately from the footprint.

Grading Group Surfaces

When the Automatic Surface Creation option is turned on, a surface is generated from the gradings. Any curves on the gradings are tessellated using the grading group tessellation settings. The grading group is added to the surface as a single operation. It appears in Surface Properties, on the Definition page, in the lower Operation Type box. By default, Automatic Rebuild is turned on for the grading surface. When working on large grading groups in large drawings, you can turn this option off to get better performance. You can add additional surface data, such as points or breaklines, to the grading group surface using the Surface Data commands. You can turn the Automatic Surface creation option on or off, as necessary.

Detached Surfaces and Infill Grading

You can also create a detached surface from a grading group by using the Create Detached Surface command, which converts the grading information into breaklines. After it is created, a detached surface is no longer linked to the grading group, so it will not update with changes to the gradings. When surfaces are created from grading groups, boundaries are created around the gradings so that the surface represents the exact definition of the gradings. If the grading closes around on itself, this creates a hole in the surface. To fill in the hole, create grading infill. You can create a grading infill in any region that is entirely enclosed by feature lines. The infill fills up the area that is joined by feature lines.
Faster Surface Rebuilds

When refining a particular grading solution, you can improve system performance by temporarily turning off automatic surface rebuilding, and editing the grading style to turn off slope shading and slope patterns. These operations take extra time, and add extra complexity to the grading process. Also, if the base grading does not have a good solution, these operations will not always complete correctly.

Using Explode With Grading Objects

If you explode a grading object, the projection lines and daylight lines become editable feature lines. You can do this to modify projection lines or a daylight line, then add them to the design surface as breaklines for use in either an existing or new grading.

Exploding the grading object creates a closed polyline that includes the footprint, projection lines, and daylight, so it completely bounds the face. Exploding the daylight alone creates a polyline from the daylight. Whether 2D or 3D polylines are created is determined by the Site Display Mode site property, which specifies either “flatten to elevation” or “use elevation.” On the other hand, you can use the ERASE or EXPLODE command on the footprint, which preserves the daylight as a feature line, but does not preserve the projection lines.

Using Feature Lines and Projection Grading Together

Sometimes, inside corners are not well suited to a projection grading solution. In reality, the projection grading result is often different from what will be constructed in the field. Let’s look at a building footprint example to illustrate a technique for using the best of both feature line tools and projection grading tools.

**TIP** The exercises described in this section are also available in the form of two detailed Grading tutorials: Tutorial: Grading from a Complex Building Footprint and Tutorial: Using Feature Lines to Modify a Grading.

We start with a building pad that already has the basic elevations assigned. In this case, the top portion of the pad is at an elevation of 402 feet and the bottom portion is at 400 feet.
In this case, let’s assume that we want to create a 1.5-foot shoulder around the pad, and then grade into the existing ground surface at −1%. At first, it might seem like slope grading is the ideal choice for both of these tasks; however, the area around the ramp needs more control than slope grading alone can provide. Let’s look at what happens when we try to apply the first criteria to this footprint, grading to a distance of 1.5 feet.
The 2D view in figure 19 looks fine, but notice in the 3D view of figure 20 how the grade twists in near the ramp:

![Figure 20: Grade twists beside the ramp](image)

Because the ramp is steeper than the specified 1% cross-slope, there is no good way for slope grading to resolve this condition within the given constraints. More importantly, the inner portion of the shoulder is now substantially steeper than 2:1, so the problem will be exaggerated when we try to grade to the surface.

What we need is more detailed control of this region than slope grading allows. Because the daylight of a slope grading is controlled entirely by the criteria, it cannot be edited except by changing the criteria of the grading. Instead, we can use the Stepped Offset command to generate a daylight line that we can edit manually to resolve the area around the ramp. First, we run the stepped offset command with the same parameters that were given to the slope grading (1.5' at –1%). This initial step yields essentially the same daylight solution as the slope graded version. However, because this is a stepped offset, we can use the full set of feature line editing tools to refine the solution. Next, we use the feature line Fillet command with a radius of 15' to create a smooth fillet between the corners of the two pads, as shown in figure 21.
Notice that the feature line fillet uses the elevations from the existing feature line, and smoothly interpolates them across the length of the fillet, as shown in figure 22.

Note that we could have used several other feature line editing tools to trim out this portion of the grading and set the desired elevations for the shoulder edge.

Now that we have a smoother feature line to grade from, we apply a 2:1 grade-to-surface criteria and create infill grading objects to handle the interior parts. Each infill grading must be completely bounded by feature lines. Figure 23 clearly shows the diamond markers for the two infill grading objects: one
for the building pads and the ramp between them, the other for the perimeter of both pads and the area between the fillets and the ramp.

Figure 23: Project graded to the surface

Figure 24 shows the same grading in a 3D shaded view. The gray area (1) is the infill grading that represents the shoulder, the gold area (2) is the pad infill grading, and the green (3) is the slope grading to the surface.

Figure 24: 3D grading
There are several more details to clean up:

- The arc portion of our ramp (area 1 in figure 25) is not triangulated very well.
- One of the triangles adjacent to the ramp (area 2) is too steep.

Figure 25: Triangulation issues

To fix the arc triangulation, we need to set a finer value for tessellation spacing in the grading group. As shown in figure 26, this can be difficult to find in the Grading Group Properties dialog box, because it can be set only when Automatic Surface Creation is enabled. However, this setting is also used for the Create Detached Surface command and infill grading triangulation. The best solution at this point is to turn on Automatic Surface Creation, change the tessellation spacing from the default value of 10 feet to 1 foot, then turn off Automatic Surface Creation again. You must click Apply after turning on Automatic Surface Creation in order to apply the changed settings.
With the tessellation spacing set correctly, you need to update the infill grading. The easiest way to do this is by selecting the interior feature line (the building pad), and using MOVE with a displacement of (0.0, 0.0, 0.0). The results are shown in figure 27.

Figure 27: Improved triangulation on one side
The arcs in the ramp (area 1) are now triangulated better, but the triangles on the right side (2) are not well distributed. To handle this last issue, we will add another feature line to the infill, using the feature line to control the elevations in the same way that a breakline is used in a surface.

First, create a polyline in the area that needs to be fine-tuned.

![Figure 28: Feature line insertion](image)

Then use the Create Feature Lines From Objects command. In this case, we want to assign elevations from grading objects so that the new feature line starts at reasonable elevations. There is no need to insert intermediate grade break points. The triangulation of the infill adjusts to accommodate the new feature line, as shown in figure 29. You can use any of the feature line editing tools to precisely control this portion of the infill grading.
Figure 29: Resolved triangulation

Figure 30 shows the 3D view of our edited grading.

Figure 30: Final result in 3D

By using feature lines and projection grading skills together, we have demonstrated how to work through a typical design process, creating an initial grading, and then optimizing it for the specific project terrain. As demonstrated in this process, after you understand the grading design concepts, and master the basic procedures, you can combine projections with feature lines, and use a range of operations to resolve the design challenges of a particular project.
Grading and Corridor Interaction

This section presents best practices for integrating gradings and corridors.

Few projects involve only corridor design or only site grading. Often you need to build and maintain a system that integrates both design approaches. Using AutoCAD Civil 3D you can create powerful relationships between corridors and site grading.

Targeting Feature Lines

Using AutoCAD Civil 3D you can target a number of items in corridor models, such as feature lines which are a key component used in site grading. This means that you can integrate corridor models and site grading models and have them react to each another. Multiple targets allow you to tie to different parts of your site grading without having to spend time creating complex alignments and profiles.

The design shown in figure 31 consists of a combination of corridors, feature lines, and gradings. Using the targeting methods discussed previously, these different components are actually tied together. In this example, if the profile for this corridor is adjusted, not only does the corridor design adjust, but also the relationship between it and the adjacent site grading is maintained.

Corridor Properties

Using the Corridor Properties dialog box, you have the capability to target survey figures and polylines, as well as alignments and profiles. To access corridor properties, select a corridor, right-click, and select Corridor Properties. The Corridor Properties dialog box is shown in figure 32.
Figure 32: Corridor properties provide targeting options

For this example, we click the Targets button for Region (1). This displays the Target Mapping dialog box as shown in figure 33. Note the objects that are referenced as targets.

Figure 33: Target references feature lines

You can add as many targets as needed for any given target point, and AutoCAD Civil 3D will simply tie to the one that it encounters first. In this case, the target is set to a feature line named Site2 Perimeter. This feature line is controlling the horizontal and vertical location of the points that are tied to from behind a curb.
Grading from a Corridor Feature Line

In order to better integrate corridor modeling with site grading, a best practice is to create a dynamic link between the corridor and the extracted feature line. Then updates to the corridor design will update the feature line. This is similar to extracting a corridor feature line and making it available for grading.

Extracting a Dynamic Corridor Feature Line

Figure 34 shows an example of a design consisting of a parking lot that is adjacent to a pond. Because of its close vicinity to the pond, the embankment behind the parking lot curb will need to interact with the pond embankment. This is a good example of how a dynamic feature line can be extracted from the corridor so that the Grading Creation tools can be used.

Figure 34: Pond next to a parking lot
In this example, the Create Feature Line From Corridor command is used to extract the feature line. We can zoom in and select the magenta back of curb feature line.

**NOTE** In the Create Feature Line From Corridor dialog box, you can create a new site and specify the feature line name and style.

A best practice is to select the Dynamic Link option in the Create Feature Line From Corridor dialog box, as shown in figure 35, so that in this example, any updates to the corridor will update the grading in this area as well. In addition, there are settings for smoothing to handle the formation of the feature line as it travels around a curved area. For more information, see Feature Line Smoothing.

![Create Feature Line from Corridor dialog box](image)

**Figure 35: Selecting the dynamic link option**
Applying Feature Line Names and Styles

It is recommended that you apply names to significant feature lines in order to distinguish them. For this example, the extracted curb feature line should be named, as it is key to the grading solution and must be easily located. Use a descriptive name, such as, Back of Curb, for the feature line.

After feature lines are created, you can edit the names of individual feature lines using the Properties command, or by using the grid control in Prospector. You can also apply a name template to a selection set of feature lines.

You can also apply styles to feature lines. As mentioned previously, styles can be used to prioritize feature lines for instances when feature lines intersect and create uneditable split points. You can determine which feature line style takes precedence to avoid split points.

Note that you can view feature lines on the Prospector tab. To access the feature line properties, on the Toolspace Prospector tab, right-click a feature line and select Properties.

Grading from the Corridor Feature Line

Now that the feature line is in place, the grading tools can tie it into the existing ground. For this example, we create a new grading group named Storm Pond and set the target surface to EG. Then we apply the grade-to-surface criteria and specify a grading region along the entire length of the parking area as shown in figure 36, using cut and fill slopes of 3:1.

The grading that is created ties back to existing ground at a slope of 3:1. Again, the feature line will maintain a dynamic link back to the corridor so any adjustments made to the corridor will affect the feature line and ultimately the grading in this area.
The ability to grade from dynamic corridor feature lines is an example of an easy to learn method that helps you to achieve dynamic object interaction and editing capabilities.

**Grade to Grade Interaction**

The interaction of one grading with another grading makes tying in design objects easier. As discussed in the previous example, the design goal is to integrate a pond grading in this area with the adjacent parking lot.
Grading from Pond Feature Line

In this example, to begin the design of the pond, the Create Feature Lines from Objects command is used to select the outermost pond polyline as shown in figure 38.

Then, we can use the Elevation Editor to set the feature line elevation. We apply an elevation so that the pond is in close proximity to the corridor feature line elevation. Then, we can use the grading creation tools to tie the pond feature line in at a 3:1 slope.
The feature line represents the top of the pond so we need to connect it to the existing ground. To grade the feature line, for the example shown here, we set the Site to Pond, the grading group to Storm Pond, and the target surface to EG. Then, we apply a grade to the entire length of the new (pond) feature line, using a 3:1 grade-to-surface criteria.

After the grading calculation has been completed, notice that the intersecting slopes between the pond and parking lot have cleaned themselves up, providing a grading solution that requires no additional work.
Now we can complete the design of the pond. Next we apply a Grade to Distance criteria using a distance of 10-feet and a grade of -2 to create a ten-foot wide area which forms the berm of the pond.

Next we specify a Grade to Relative Elevation criteria with a difference of -12 and slope of 3:1 to grade from the berm to what will be the pond bottom. The resulting slope descends 12-feet to define the depth of the pond, as shown in figure 40.

![Figure 40: Pond slopes graded to distance and elevation](image)

The last step is to use the Create Infill command to add a bottom to the pond. Note that an infill can only be used to fill an area that is enclosed by feature lines. The pond bottom is completed, as shown in figure 41.

![Figure 41: Grading infill is the bottom of the pond](image)
Grading Volume Tools

Use the Grading Volume Tools to view the cut and fill results for your design. These tools can help you to quickly complete a design such as a detention pond. When the grading is completed, you can incrementally raise and lower the pond, updating the volume calculations each time. There is also a tool that will balance the earthwork for this grading group.

Size by Volume

If you are designing a detention pond and want to size it by volume, it may help to create a temporary surface to use as the Volume Base Surface for comparison. To do this, draw a polyline around the pond rim, assign it the rim elevation, and add it as breakline data to a surface. When you use such a surface as the Volume Base Surface for the grading group, you can more easily see how much volume the pond can contain.

Remember that Automatic volume balancing is an iterative process. If the initial result is not satisfactory, you can adjust the gradings up or down in smaller increments until you achieve the target volume.

Figure 42: The volume tools adjust the cut and fill and balance the grading group

In the past, cleaning up between gradings would have been the designer’s responsibility, but now AutoCAD Civil 3D completes this task. In addition, you can use the Grading Volume Tools to quickly analyze and adjust different design scenarios.
Pipe Networks

This section describes best practices for working with pipe networks parts catalogs, as well as for creating, editing, and labeling pipe networks.

How the Parts Catalog Works

This section explains best practices for using the parts catalog, and describes particular work scenarios that can cause problems.

When pipe networks are created or edited, AutoCAD Civil 3D references the parts catalog for information about each part (pipe or structure). You can use the Part Builder utility to edit the data for any part, and to expand the catalog by creating additional custom parts. As shown in figure 1, each part is defined by three files with the same root name but different extensions:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AeccCircularConcretePipe_Imperial.bmp</td>
<td>118 KB</td>
<td>ACDSee BMP Image</td>
</tr>
<tr>
<td>AeccCircularConcretePipe_Imperial.dwg</td>
<td>200 KB</td>
<td>AutoCAD Drawing</td>
</tr>
<tr>
<td>AeccCircularConcretePipe_Imperial.xml</td>
<td>6 KB</td>
<td>XML Document</td>
</tr>
<tr>
<td>AeccCircularDIFPipe_Imperial.bmp</td>
<td>118 KB</td>
<td>ACDSee BMP Image</td>
</tr>
<tr>
<td>AeccCircularDIFPipe_Imperial.dwg</td>
<td>200 KB</td>
<td>AutoCAD Drawing</td>
</tr>
<tr>
<td>AeccCircularDIFPipe_Imperial.xml</td>
<td>5 KB</td>
<td>XML Document</td>
</tr>
</tbody>
</table>

Figure 1: Catalog files for two types of circular pipe

If you use Part Builder to modify a part, you will probably change the XML file, as it contains the detailed dimensions and calculations. Changes to the DWG and BMP files are possible, but not essential in every case.

AutoCAD Civil 3D installs the default pipe network parts catalog at C:\Documents and Settings\All Users\Application Data\Autodesk\C3D <version>\enu\Pipes Catalog. You can point your drawing to a different catalog by clicking Home tab ➪
Create Design panel ➤ Set Pipe Network Catalog, and then changing the settings in the dialog box shown in figure 2.

Figure 2: Dialog box for specifying the pipe network catalogs

Multi-User Environment

In a multi-user work environment with multiple parts catalogs, it is easy to create unwanted changes in drawings if your parts catalogs do not have consistent contents and standard locations. Unwanted changes can occur because each drawing references the parts catalog at the location specified on the computer on which it was created. If the drawing is opened on a different computer, where it cannot find a catalog at the same location, it points to the default location, or whatever is defined on the second computer.

Unwanted changes can occur to parts in the drawing if the following conditions are met:

■ The user of the second computer edits the pipe network with an operation that references the parts catalog.

■ The referenced part has specifications in the current catalog that differ from those in the original catalog.

Under these conditions, the part specifications from the current catalog are applied to the part in the drawing.

Operations that reference the catalog—and can introduce unwanted changes—include adding a part to the network or moving a part. Other operations, such as editing a label, do not reference the catalog.
Parts Catalog Management Practices

To prevent errors in multi-user environments, use the following practices for managing pipe network part catalogs:

- When changes to a parts catalog are expected, designate a single person (the ‘catalog manager’) to be responsible for changing and maintaining the master parts catalog.

- When the master catalog changes, the catalog manager distributes the updated catalog to all users or offices.

- Users send all new or modified parts to the catalog manager for addition to the master catalog. Among the team, agree on a standard process for doing this. For example, users could send to the catalog manager an entire catalog folder, or just the affected files (DWG, XML, and BMP) for a single part.

- If all users store their parts catalogs locally on their computers, the catalogs should be in the same location, preferably the default C: drive path used by AutoCAD Civil 3D.

- If a number of users are on the same network, a single pipes catalog can be stored in a central network location. In this case, it is important for users to avoid changing the shared catalog, as they could interfere with the work of other users. Instead, the catalog manager should be responsible for making all changes and notifying the users.

- When a new or modified part is required, always use Part Builder to make the edits. Manual edits to an .xml file can produce unwanted results.

- When modifying a default part, save it with a new name so that it can be easily distinguished from the original part.

- When sharing a drawing with another user, prevent unwanted part changes by setting the pipe network catalog to the same location, such as a shared network drive, or the default C: drive. If two separate catalogs are involved, verify that their contents are identical.

- AutoCAD Civil 3D uses the US Imperial Pipe Catalog and US Imperial Structure Catalog, by default. When creating a pipe network, if you are working with metric drawings, change the Pipe Catalog to metric. Click Home tab ➤ Create Design panel ➤ Set Pipe Network Catalog ➤. In the Pipe Network Catalog Settings dialog box, select US Metric Pipes and US Metric Structures for the Pipe Catalog and Structure Catalog fields, respectively.
Standardizing Pipes and Structures

Pipe network parts catalogs are a convenient mechanism for standardizing the specifications of pipes and structures across project drawings. But it is important for all users to understand how AutoCAD Civil 3D consults these catalogs and updates drawings during the editing process. In any environment where multiple users are sharing drawings, they should follow a standard procedure for maintaining and distributing the pipe network parts catalog to avoid unwanted part changes in drawings.

All parts catalogs in use by a design team should be identical, and they should be stored in consistent locations. If this is done, the parts catalogs are referenced in a predictable way, and it is easier to find and update them when required.

Problematic Scenarios

The following sections describe scenarios that can cause unexpected changes in pipe network drawings. Solutions are provided that can prevent or recover from the problem outlined in each scenario.

Local Catalogs and a New Part

1. Users A and B are both using AutoCAD Civil 3D with the default pipe network catalog path (C:\Documents and Settings\All Users\Application Data\Autodesk\C3D <version>\enu\Pipes Catalog).

2. User A creates a new part and uses the part in Drawing 1. This new part exists only in the catalog on A’s computer.

3. User B edits Drawing 1 on his computer, and parts are referenced from the catalog. The new part created by user A is not available, so AutoCAD Civil 3D uses the closest part it can find. As a result, the part in Drawing 1 is changed.

Solution: User A sends the new part to the catalog manager, who distributes it to User B and others, maintaining standard catalogs that contain identical parts.
Local Catalogs and a Modified Part

1. Users A and B are both using AutoCAD Civil 3D with the default pipe network catalog path (C:\Documents and Settings\All Users\Application Data\Autodesk\C3D <version>\enu\Pipes Catalog).

2. User A modifies an existing part X and uses the part in Drawing 1. The name of part X is not changed.

3. User B edits Drawing 1 on her computer, and parts are referenced from the catalog. Part X is found and used, but it is the default part X, not including the changes made by user A.

**Solution:** User A saves the modified part with a different name, and sends the part to the catalog manager, who distributes it to User B and others. When modifying parts, users should change the part name to clearly identify the new part.

Part Catalogs on Different Networks

1. User A is using AutoCAD Civil 3D with the pipe network catalog path set to a network location, such as N:\Autodesk\Civil3D <version>\Pipes Catalog.

2. User A creates a new part and uses the part in Drawing 1.

3. User B, in another office, edits Drawing 1 on his computer, which has the pipe network catalog path set to a different network location, such as J:\Autodesk\Civil\Pipes Catalog. Drawing 1 searches for the pipes catalog on the N: drive but does not find it. Therefore, AutoCAD Civil 3D substitutes the most similar part from the catalog on the J: drive and uses it instead.

**Solution:** User A sends the new part to the catalog manager, who distributes it to User B and others to maintain consistent catalogs. Users of networked catalogs in different offices should agree to use the same drive letter and path for their parts catalogs. If this is done, drawings can be shared reliably and it is easier to maintain standard catalogs.

Drawing Shared Between Two Companies

1. Company A is using AutoCAD Civil 3D with the pipe network catalog either locally or on the network. Company A creates a new part or
modifies an existing part. That part is used in a pipe network in Drawing
1. The drawing is given to Company B.

2 Company B opens and edits the drawing, which points to the path where
the catalog resided at Company A. If that was the default location, the
drawing finds that path at Company B and looks there for the part.
If the saved path was a network location that does not exist at Company
B, AutoCAD Civil 3D looks in Company B’s default catalog location. If
the part is a standard AutoCAD Civil 3D part with the name unchanged,
it uses the one in Company B’s catalog, regardless of whether it resembles
the one Company A intended.
If the part is new or a renamed standard AutoCAD Civil 3D part, the
software looks in Company B’s catalog for the most similar part.

Solution: Company A provides a copy of its parts catalog along with the
drawing, asking Company B to reference this catalog, or update its current
catalog to include the changes. Ideally the changes are clearly identified so
that Company B can determine whether the updates from Company A would
introduce any unwanted changes to other drawings.

Creating User-Defined Optional Properties

To add further definition to a part, you can assign optional properties to a
part size definition in a parts list. You can create a user-defined property to
display information such as pipe design discharge.

Assign Optional Properties to a Part Size

One way to customize a part is to add a property to the part size. In the
following example, you will create a property by editing the Part Parameter
Configuration file.

To assign optional properties to a part size

1 Navigate to the Part Parameter Configuration xml file
   (AeccPartParamCfg.xml). The default location is C:\Documents and
   Settings\All Users\Application Data\Autodesk\C3D <version>\enu\Pipes
   Catalog\Aecc Shared Content

2 Open the file and right-click ➤ View Source to modify the file.
Navigate to the `<AeccParamDeclaration>` section. A sample optional property is the Hazen Williams Coefficient flow analysis. The entry for this is as follows: `<AeccDfParameter name="ACHW" desc="Hazen Williams Coefficient" context="FlowAnalysis_HazenWilliams" index="0" datatype="Float" usage="Double_General" unit="" visible="True" internal="True"/>

Copy an existing optional property and make changes as appropriate to create a new property.

In the `<AeccParamUsage>` section, the corresponding entry for the sample in step 3 is `<AeccOptParam context="FlowAnalysis_HazenWilliams"/>`. Copy and modify an entry as appropriate to create a new entry for your property.

Save and close the xml file.
Parts Lists

The following sections describe best practices for using Parts Lists.

Backup Part Catalog

It is a good practice to make a copy of the entire Part Catalog directory before you modify anything. If you make any mistakes, you can replace the Part Catalog with your copy. Otherwise, you have to reinstall AutoCAD Civil 3D. Make a copy of C:\Documents and Settings\All Users\Application Data\Autodesk\C3D <version>\enu\Pipes Catalog and store in a secure place, such as a backup drive or disc.

Parts List Rules

When building a parts list, you create a list of parts for a given system type, and assign them the desired styles. Rules are never run automatically, only at creation time and when the Apply Rules command is run. You can apply rules by selecting a pipe or structure in a drawing, then right-click and click Apply Rules. This is designed so that undesired changes are not made automatically, or accidentally; you must actively run them.

You can bulk edit part list rules and styles in the Panorama view. Right-click on the column header and select Edit.

Pipe and Structure Rules

For best results, it is not recommended that you customize rules. Part Rules are only intended to determine the best initial pipe and structure elevations during pipe creation. These are checked against the surface being referenced by the network parts. In the drawing, right-click a pipe and click Pipe Properties. In the Pipe Properties dialog box on the Rules tab, edit Rule set parameters such as minimum slope and depth to achieve the best results.

If you edit network parts, rules are never re-run automatically, to avoid inadvertent or unwanted changes to pipe or structure elevations. To re-run rules, use the Apply Rules command.
Renaming Part Size Name

Renaming part list names is done individually. When a part size is added to a parts list, a part size name is automatically generated. For example, \textit{16 x 24 inch Egg-Shaped Culvert MCR\_0.000000 ACM\_0.000000 ACHW\_0.000000 ACDW\_0.000000 Material\_}. This name is impractical for use in a label, so you should rename the part sizes using a convention such as \textless Size/Material/Shape\textgreater. An example is 72-inch RCP, in which RCP stands for reinforced concrete pipe. Another option is to create a label that includes the actual part size value and also displays a material description using an acronym that you standardize for your company.

Pipe Network Design

The following sections describe best practices when designing a pipe network.

\textbf{Specifying Styles}

Right-click a collection on the Prospector tab to batch change properties such as style, rule, or render material.
You can quickly edit the styles of many pipes or structures in the Prospector tab for that pipe network as shown in figure 3.

To bulk edit pipes or structures

1. Right-click the Pipes collection on the Toolspace Prospector tab.
2. Press the shift key and select the desired pipes, then in the item view, right-click the Style column header and select Edit.
3. You are prompted to choose a different style. Make your selection and the selected pipes are updated in the drawing.
One Network Per Network Type

Components in a pipe network do not have to be directly connected. It is a good idea to create one pipe network per network type per project. For example, one Sanitary Network, one Storm Drainage Network, one Water Network, and so on. This allows for easier editing and rerouting of the system. Experiment with your sites to find the best solution for you.

Rerouting Pipes

You cannot connect pipe network elements from different networks. Therefore, create a single network that includes all parts that might eventually need to be connected. For example, include all storm drainage structures and pipes in a single pipe network. During the course of your design, you may find that a particular section of pipe should be connected to a different structure.

Networks in Profile and Section Views

The following sections describe best practices for displaying pipe networks in profile and section views.

Pipe Appearance in Section View

Pipe sections are drawn using the FACETDEV (Facet Deviation) system variable. This variable controls the smoothness (tessellation) of curved edges of the pipes in section view.

The default value of FACETDEV will usually cause pipe sections to be displayed in section views with line segments, rather than as smooth curves. The following illustration shows an elliptical culvert in section view when FACETDEV is set to 0.5 feet.

If you set FACETDEV lower, to 0.01 for example, the appearance of the pipe sections will become more circular, as shown in the following illustration.
The number you specify for facet deviation defines the maximum distance from the chord to the arc—the chord being an edge that is created from faceting the curve to the true mathematical arc. The facet deviation has a range of greater than zero (0) and no upper limit. The lower this variable is set, the more segments will be used to draw the pipe. The minimum number of segments is 8.

**NOTE** The maximum number of facets is controlled by the FACETMAX variable. This variable can be set from 100 to 10,000. Note that using a small value for FACETDEV and a large value for FACETMAX will adversely affect drawing performance.

**NOTE** FACETDEV and FACETMAX are AutoCAD Civil 3D variables (rather than AutoCAD variables). They are therefore not listed when using the AutoCAD command SETVAR.

To change the FACETDEV variable

1. At the command line, enter **FACETDEV**.
2. At the Set New Facet Deviation prompt, enter **0.01**. Adjust the value to a smaller number if greater smoothness is required.

**Pipe Connection Display in Profile**

Use the Clean Up Pipe To Pipe Connections option in the Pipe Style dialog box, as shown in figure 4, to improve the appearance of pipe profiles so that the pipes graphically appear to line up as expected. This option is not enabled by the default, so you must select it.

To enable pipe clean up

1. Select a pipe in the drawing.
2. Right-click and click Edit Pipe Style.
3. Select the Profile tab in the Pipe Style dialog box.
Select the Clean Up Pipe to Pipe Connections check box.

![Figure 4: Dialog box for selecting pipe connection clean up](image)

Create From an Alignment

Creating an alignment from network parts is a good method for generating pipe run profiles. If your local agency standards require profiles for pipe network centerlines, use the Create Alignment From Network command to convert alignments to networks.

Grip Editing in Profile View

When grip editing pipes and structures in profile view, a good practice is the use of the transparent command station/elevation. This is useful if you need to set a grip (Pipe ends/Structure rim or sump) at a certain elevation. You can also match the crown invert of adjacent pipes across structures. In general, grip editing enables you to more easily modify slopes and elevations.

Convert 3D Polylines

A good method for creating water and gas line pipe profiles is to create a 3D polyline and then convert it to a pipe network.
To convert a 3D polyline

1 Use the Survey feature to convert survey data to a 3D polyline object.
2 Use the Create Pipe Network From Object command to convert the 3D polyline into a pipe network.

Based on the vertices of the 3D polyline, AutoCAD Civil 3D will place structures on the network.

Managing Pipe Data

The following sections describe best practices for managing pipe data.

Locating Pipe Network Parts

The best way to locate and identify a single pipe or structure embedded within a large network is to know the part name. When you create pipes and structures, assign them meaningful names so that they are easily distinguishable. Use a consistent naming convention so that you can locate the part on the Prospector tab. You cannot zoom to the Prospector tab to display a part, but you can zoom from the Prospector tab to the part in the drawing.

Pipe Networks that Traverse Multiple Surfaces

A common scenario is a pipe network that crosses multiple surfaces. One way to handle this is to divide the network into two separate networks, each with its own associated surface. Note that the network properties have a default surface and alignment that is assigned to each part. These defaults can be changed at any time and for any given part. You can change the default references in bulk by right-clicking the item view or Panorama column header.

Another useful method when creating a pipe network that would cross multiple surfaces, is to create a composite of the two surfaces. For example, if you have an existing road surface and a finished ground surface, you can create a composite volume by which to define the network. For more information, see .
Renaming Pipe Network Parts

When pipe network parts are created, they are automatically assigned names and numbers. If the default naming/numbering process does not give desired results (the numbers themselves and/or the direction of numbering) you can use the Rename Networks Parts command to automatically rename and optionally renumber a series of pipes and structures. Select a linear series of connected pipes and structures, and automatically rename them to more easily manage the network. Use this command so that you do not have to individually locate and manually rename components.

To rename pipe network parts

1. On the Pipe Networks contextual ribbon, click Modify panel ➤ Rename Parts.
   You can select to rename/renumber just pipes, just structures, or both.

2. In the drawing, click to select the part(s) to rename and press Enter. The Rename Pipe Network Parts dialog box is displayed (figure 5).
Network Labeling Strategies

The following sections describe best practices for annotating network parts and structures.

Spanning Pipes

You can add spanning labels to pipes in profile view in the same way you can add them in plan view. Just as for pipes in plan view, you can move profile span labels to any connected pipe or structure in the span.
NOTE  The AutoCAD LIST command is a good method to list the connected pipes in the span.

Breaking Pipes

As it is not always feasible to complete layout before creating labels, you can use spanning labels to annotate pipe spans. Spanning labels are useful in places where you have connected a lateral to a pipe. When a lateral is connected to a pipe, the original pipe is broken at the connection point. A spanning label annotates the two broken pipe segments as if they were still one continuous pipe.

Spanning Multiple Segments

Spanning labels are also useful when you have long continuous pipes of multiple segments such as curves, or when you are using pipes to represent a “flexible” underground utility. The spanning label will label a number of pipe segments as if they are one continuous pipe.

Labeling Pipe External References

You can label pipe network xref data. After inserting the xref data, label the pipes and structures as if they are in the current drawing. Tables cannot be created for pipe xref data.
Hydraflow Extensions

The following sections describe best practices for collecting and migrating hydrology and hydraulics data.

Importing/Exporting Storm Sewers Data

This section describes best practices when planning to import or export Storm Sewers data.

- Select the AutoCAD Civil 3D NCS template (or custom template).
- Navigate to the Settings Toolspace tab, right-click Pipe Network, and then select Edit Feature Settings. You should review the Storm Sewer Migration Defaults and confirm the default selections.
- If you do not use the template listed above, you can create a full parts list by using the Create Full Parts List command and ensuring that the "Full Catalog" parts list is being used under the Storm Sewer Migration Defaults setting (noted previously).
- If you want to create a part in AutoCAD Civil 3D that has the same naming convention as the Storm Sewers parts (for example, Drop Grate or Grate Inlet), you use Part Builder to create a part.
- If you work with a large number of pipe networks in AutoCAD Civil 3D and plan to export more than 250 pipes (or a combination of pipes and structures), you should create more than one network. Each network can then go into a separate .stm file. Storm Sewers prevent you from importing files with more than 250 pipes and structures.
- If you want to export a pipe network or multiple networks from AutoCAD Civil 3D and intend to work with the pipe networks in Storm Sewers immediately after export, you should use the Edit In Storm Sewers command.

To access this command, select a pipe network. Then click Pipe Networks tab ➤ Analyze panel ➤ Storm Sewers ➤ Edit in Storm Sewers. This exports the networks to a file and also launches the Storm Sewers extension at the same time.
Switch Between Imperial and Metric Units

In the Hydrographs and Express Extensions, you can now switch between imperial units and metric units. Be sure to select the appropriate units before using the extensions or saving project files.

Hydraulic Grade Line and Energy Grade Line

In the AutoCAD Civil 3D pipe style, the Hydraulic Grade Line and Energy Grade Line are turned off (Display set to Off) by default. To display these properties, create a new pipe style with these options turned on and save the pipe style for future use. Also, if you want to display the HGL/EGL information in labels (in addition to the profile view), create a new pipe label and/or structure label that contains this information.

US Survey Foot Units

In Storm Sewers, you can use an option in the Import/Export LandXML dialog box to choose "USSurveyFoot as Linear Unit". If you are working with a file that was imported into Storm Sewers as USSurveyFoot or plan to work with a Civil 3D drawing that contains USSurveyFoot units, select this check box.

Hydrograph Pond Tools

When using the Pond Tools in Hydrographs, you can enter only up to 20 elevations during creation of the pond. Use the appropriate increment to fit all required elevations to this limit.

Hydrograph Time Intervals

In Hydrographs, each hydrograph created contains 2880 points. Using a 1-minute Time Interval provides a 2880-minute time coverage, or 48 hours. To cover a greater time period, increase the Time Interval value to 2 minutes (or greater as necessary).
Updating .STM Files

The 2010 version of the .stm file has changed from earlier versions. However, previous versions of the .stm file (2009 and earlier) can be imported into AutoCAD Civil 3D with the import command.

When importing .stm files from previous versions, they can contain Hydraulic Grade Line (HGL) values but will not contain some of the other hydraulic properties.

The following pipe values are calculated in Storm Sewers but are not found in older versions of the .stm file (before 2010):

- Energy Grade Line Up
- Energy Grade Line Down
- Flowrate

The following structure values are calculated in Storm Sewers but are not found in older versions of the .stm file (before 2010):

- Energy Grade Line
- Known Capacity

Obtain the missing pipe and structure values

To obtain these missing values, open the older version of the .stm file with the 2010 version of Storm Sewers. Then run the calculation again and save.

The .stm file will then contain the values listed previously and will display them in AutoCAD Civil 3D after using the import .stm file command.

Convert Rainfall Data to Correct Units

Note that many countries that use metric units tend to measure rainfall data in millimeters per hour (mm/hr). In all three Hydraflow Extensions, the rainfall data is shown as centimeters per hour (cm/hr), for example in the Intensity-Duration-Frequency (IDF) Curves or the Precipitation dialog boxes. Be sure to convert millimeters to centimeters to avoid errors.
Collecting Rainfall Data at a Constant Rate

The Hydraflow Extensions include a Rainfall Intensity-Duration-Frequency (IDF) Curve dialog box, used for entering rainfall data and/or importing files that contain rainfall data. In the Rainfall IDF Curve dialog box, as shown in figure 6, there are equations you can use to create an IDF graph. You can also enter rainfall data at a constant rate instead of using the default IDF graph.

![Figure 6: Default IDF Graph](image)

The dialog box and a graph resulting from one of the equations, as shown in Figure 7. In the graph shown in figure 7, note the curve in the graph of rainfall (in/hr) over time.

It is often desirable to set this data (in/hr) at a constant rate over time which would display the information as a straight-line graph rather than a curve.
Figure 7: Default graph curve

**Set a Constant Rainfall Rate**

It is recommended that you take advantage of the FHA equation and manipulate the values to create a constant rate. There are three coefficients in this equation, as shown in figure 8, but only one of them will have an actual value.

The coefficients for the equation are B, D, and E. You should set the values for D and E to zero (0). The B value would be the intensity in inches/hour.
Figure 8: Set values for constant rate.

The resulting graph as shown in figure 9 is a straight-line graph, as you would expect from a constant rate.
Storm Sewers Default Parts Matching

There are Default Parts Matching limitations when importing and exporting data from Storm Sewers to AutoCAD Civil 3D, and then back to Storm Sewers.

In Storm Sewers, there are seven Rectangular Junction Structures. In AutoCAD Civil 3D, there are only four Rectangular Junction Structures. In Storm Sewers there are seven Cylindrical Junction Structures. In AutoCAD Civil 3D there are six Cylindrical Junction Structures.

A best practice is to determine what Junction Types are being used in a given Storm Sewers Project (stm file) and set up the Part Matching Defaults to ensure that:

1. Each Storm Sewer part used is matched with a unique AutoCAD Civil 3D Part Family in the Import Tab.
2. Each of those AutoCAD Civil 3D Part Families that match the Storm Sewer parts that are in the STM file are matched to the appropriate Storm Sewer part in the Export tab.
## Proposed Import Matching

### Cylindrical

<table>
<thead>
<tr>
<th>Storm Sewer Structure Type</th>
<th>AutoCAD Civil 3D Part Family</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combination Inlet</td>
<td>Concentric Cylindrical Structure</td>
</tr>
<tr>
<td>Curb Inlet</td>
<td>Cylindrical Structure Slab Top Circular Frame</td>
</tr>
<tr>
<td>Drop Curb</td>
<td>Cylindrical Junction Structure NF</td>
</tr>
<tr>
<td>Drop Grate</td>
<td>Cylindrical Junction Structure NF</td>
</tr>
<tr>
<td>Generic Inlet</td>
<td>Eccentric Cylindrical Structure</td>
</tr>
<tr>
<td>Grate Inlet</td>
<td>Eccentric Cylindrical 2-Tier Circular Frame</td>
</tr>
<tr>
<td>Manhole Inlet</td>
<td>Concentric Cylindrical Structure NF</td>
</tr>
</tbody>
</table>

### Rectangular

<table>
<thead>
<tr>
<th>Storm Sewer Structure Type</th>
<th>AutoCAD Civil 3D Part Family</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combination Inlet</td>
<td>Rectangular Junction Structure NF</td>
</tr>
<tr>
<td>Curb Inlet</td>
<td>Rectangular Junction Structure NF</td>
</tr>
<tr>
<td>Drop Curb</td>
<td>Rectangular Structure Slab Top Circular Frame</td>
</tr>
<tr>
<td>Drop Grate</td>
<td>Rectangular Structure Slab Top Rectangular</td>
</tr>
<tr>
<td>Generic Inlet</td>
<td>Rectangular Junction Structure NF</td>
</tr>
<tr>
<td>Grate Inlet</td>
<td>Rectangular Junction Structure NF</td>
</tr>
<tr>
<td>Manhole Inlet</td>
<td>Rectangular Structure 2-Tier Circular</td>
</tr>
</tbody>
</table>
### Proposed Export Matching

**Cylindrical**

<table>
<thead>
<tr>
<th>AutoCAD Civil 3D Part Family</th>
<th>Storm Sewer Structure Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concentric Cylindrical Structure</td>
<td>Combination Inlet Circular</td>
</tr>
<tr>
<td>Concentric Cylindrical Structure NF</td>
<td>Manhole Circular</td>
</tr>
<tr>
<td>Concrete Rectangular Headwall</td>
<td>Headwall</td>
</tr>
<tr>
<td>Concrete Rectangular Headwall Variable Height</td>
<td>Headwall</td>
</tr>
<tr>
<td>Cylindrical Junction Structure NF</td>
<td>Drop Curb Circular</td>
</tr>
<tr>
<td>Cylindrical Structure Slab Top Circular Frame</td>
<td>Curb Inlet Circular</td>
</tr>
<tr>
<td>Eccentric Cylindrical 2-Tier Circular Frame</td>
<td>Grate Inlet Circular</td>
</tr>
<tr>
<td>Eccentric Cylindrical Structure</td>
<td>Generic Inlet Circular</td>
</tr>
<tr>
<td>Rectangular Junction Structure NF</td>
<td>Combination Inlet Rectangular</td>
</tr>
<tr>
<td>Rectangular Structure 2-Tier Circular Frame</td>
<td>Manhole Rectangular</td>
</tr>
<tr>
<td>Rectangular Structure Slab Top Circular Frame</td>
<td>Drop Curb Rectangular</td>
</tr>
<tr>
<td>Rectangular Structure Slab Top Rectangular Frame</td>
<td>Drop Grate Rectangular</td>
</tr>
</tbody>
</table>

**NOTE** With these mappings, Storm Sewers Combination Inlet Rectangular, Generic Inlet Rectangular, and Grate Inlet Rectangular will all be converted to Combination Inlet Rectangular when imported from, then exported back to Storm Sewers.
Digging It: Display Flow Capacity with Manning Equation

You can use an expression for Manning’s equation to label pipes, in plan or profile view, in order to display their flow capacity. This process was developed by Jeffrey Old, a licensed P.E., and AEC Solutions Engineer with Hagerman & Company, Inc., based in Mt. Zion, Illinois, USA (http://www.hagerman.com). Jeffrey has provided advice on how to use expressions to design pipes hydraulically, as well as an explanation of how these expressions work.

Manning Equation

With the use of a mathematical expression for Manning’s equation, you can label pipes in plan or profile to display their flow capacity as a basis for analyzing the overall capacity of your network. AutoCAD Civil 3D does not have the ability to design pipes based on a flow value, which is usually expressed in cubic feet per second. However, with the expression, you can design hydraulically. This is a good example of how the creative use of expressions with label styles can greatly improve your network designs.

Manning’s equation is considered the engineering default for calculating gravity flow in a pipe. This equation is an expression using four components of a pipe. The four components are:

- Cross-sectional area of flow expressed in square feet
- Slope expressed in feet of fall over feet of run
- Hydraulic radius expressed in feet and calculated as flow cross-sectional area divided by the wetted perimeter
- A roughness coefficient known as Manning’s “n” value which has no units.

The basic equation in English (imperial) units is as follows:

\[ Q = \frac{1.49}{n} \times \text{Area} \times (\text{hydraulic radius})^{2/3} \times (\text{slope})^{1/2}, \] where Q is flow in cubic feet per second.
By assuming that a pipe's theoretical maximum capacity occurs when flowing 100% full, the hydraulic radius for a circular pipe can be reduced to a simple term:

- Hydraulic radius = area / perimeter
- Hydraulic radius = \( \frac{\pi r^2}{2\pi r} \)
- Hydraulic radius = \( \frac{r}{2} \), where \( r \) is radius in feet.

Using this simplification, Manning's equation for circular pipe flowing full can be reduced to a function of pipe radius, slope, and roughness:

- \( Q = \left( \frac{1.49}{n} \right) \pi r^2 \left( \frac{r}{2} \right)^{2/3} (\text{slope})^{1/2} \)

**Display Pipe Components**

You can compose object label styles in AutoCAD Civil 3D using the basic components of the objects they are designed to label. For example, set up a label style for a parcel line to display the bearing and distance of that line, which are two of its basic components. Similarly, set up pipe label styles to display a pipe's basic components, such as slope or diameter, in plan or profile view. Taking this a step further, you can create tables with fields populated by the basic components of a series of parcel lines or pipes.

**Spot Elevation Expression**

With label styles, you can create and name mathematical expressions based on the components of the objects they are labeling. For example, you can create an expression for spot elevations on a surface, which subtracts a given value from the actual surface elevation. The expression could be called \texttt{SUBGRADE} and the composition might look something like this: \( \{\text{Surface Elevation}\}-2 \), where \texttt{Surface Elevation} is a component, or named property, of the surface.

After it is created, that expression can be used as a component for label styles and table styles. Simply create a Spot Elevation surface label style employing the expression called \texttt{SUBGRADE}. Use the New Expression dialog box, as shown in figure 10.
You can create a custom expression for flow in a full circular pipe.

**To create the expression**

- In Toolspace, on the Settings tab, expand a pipe label style collection.
- Right-click Expressions and click New.
- In the New Expression dialog box, enter the name as FLOW.
- Enter the following expression:
  
  \[1.49 \times \pi \times \left(\frac{\left(\text{Start Crown Elevation} - \text{Start Invert Elevation}\right)}{2}\right)^2 \times \left(\frac{\left(\text{Start Crown Elevation} - \text{Start Invert Elevation}\right)}{4}\right)^{0.6667} \times \text{SQRT}(\text{Pipe Slope})\]

- Click OK.
Figure 11: Flow capacity expression

**NOTE** The term \(((\text{Start Crown Elevation} - \text{Start Invert Elevation})/2)\) has been substituted for Pipe Radius. The use of Pipe Radius, which is a named component of the pipe, does not work correctly in this case. Similarly, do not use the \{Inner Pipe Diameter\} component.

This expression assumes a Manning’s “n” value of 0.013, which is the standard for concrete pipe. In fact, pipes have a named component for Manning’s “n” value, which you can set. However, adding that component to your expression yields an undesired result, so you should not use it for this procedure.

**Create Flow Label Style**

The next step is to create a pipe label style for plan and profile that displays this value for flow. Figure 12 shows an example of this label style with all the pertinent hydraulic settings:
Display the flow capacity for design purposes. When you want to produce your construction plans, assign a style more suitable for production drawings. As pipes are created and labeled, the label style DESIGN FLOW will display the flow capacity (Q) of the pipe.

The flow capacity label is especially effective in profile view where you can adjust the invert grips of each pipe until the desired pipe capacity is reached. You may need to follow each iteration of invert raising or lowering with a REGEN command to regenerate the drawing.

You can create pipe and structure tables in AutoCAD Civil 3D. Now, with the added expression for flow, you can easily add the capacity of a pipe to a table.
These expressions demonstrate the importance of fully exploring the capability of mathematical expressions with AutoCAD Civil 3D. Making a couple of assumptions, it is easy to see that any user with a simple understanding of Manning’s equation can create an expression for flow capacity and compare that value to the expected flow calculated by the design storm. Then the user can use this comparison to help set the diameter and slope of a pipe.

For more AutoCAD Civil 3D tips and tricks, see Jeffrey Old’s technology bulletin postings at the Hagerman & Company, Inc. website: http://newsletters.hagerman.com/newsletters.
Index

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>adaptive degradation setting  26</td>
<td>best practices</td>
</tr>
<tr>
<td>alignments</td>
<td>Autodesk Vault</td>
</tr>
<tr>
<td>for corridors</td>
<td>drawing templates</td>
</tr>
<tr>
<td>site interaction</td>
<td>external references, project management</td>
</tr>
<tr>
<td>assemblies</td>
<td>grading</td>
</tr>
<tr>
<td>for corridors</td>
<td>label styles</td>
</tr>
<tr>
<td>assembly offsets</td>
<td>large data sets</td>
</tr>
<tr>
<td>AutoCAD system variables, setting 25</td>
<td>other sources</td>
</tr>
<tr>
<td>Autodesk Vault</td>
<td>parcels</td>
</tr>
<tr>
<td>administration tool  76</td>
<td>parts catalogs</td>
</tr>
<tr>
<td>and Microsoft Office 78</td>
<td>pipe networks</td>
</tr>
<tr>
<td>configuration 69</td>
<td>plan production</td>
</tr>
<tr>
<td>multi-site 70</td>
<td>points and surfaces</td>
</tr>
<tr>
<td>multiple vaults 72</td>
<td>project management</td>
</tr>
<tr>
<td>project interfaces 75</td>
<td>styles</td>
</tr>
<tr>
<td>working folder options  73</td>
<td>survey</td>
</tr>
<tr>
<td>C</td>
<td>D</td>
</tr>
<tr>
<td>code set styles  97</td>
<td>data management</td>
</tr>
<tr>
<td>contour data, flat areas  88</td>
<td>referencing</td>
</tr>
<tr>
<td>corridors</td>
<td>resolution</td>
</tr>
<tr>
<td>best practices</td>
<td>data clip boundary</td>
</tr>
<tr>
<td>Autodesk Vault</td>
<td>data shortcuts, XML files</td>
</tr>
<tr>
<td>corridors</td>
<td>default template, specify</td>
</tr>
<tr>
<td></td>
<td>DEM export</td>
</tr>
<tr>
<td></td>
<td>Digging It</td>
</tr>
<tr>
<td></td>
<td>drag and drop styles</td>
</tr>
<tr>
<td></td>
<td>drawing</td>
</tr>
<tr>
<td></td>
<td>settings</td>
</tr>
<tr>
<td></td>
<td>structure, section views</td>
</tr>
<tr>
<td></td>
<td>templates</td>
</tr>
<tr>
<td></td>
<td>E</td>
</tr>
<tr>
<td>editing</td>
<td>feature line labels</td>
</tr>
<tr>
<td>survey tips 48</td>
<td></td>
</tr>
<tr>
<td>boundary for surface  81</td>
<td></td>
</tr>
<tr>
<td>boundary representation (grading) 139</td>
<td></td>
</tr>
<tr>
<td>breaklines, adding  84</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>D</td>
</tr>
<tr>
<td>code set styles  97</td>
<td>data management</td>
</tr>
<tr>
<td>contour data, flat areas  88</td>
<td>referencing</td>
</tr>
<tr>
<td>corridors</td>
<td>resolution</td>
</tr>
<tr>
<td>best practices</td>
<td>data clip boundary</td>
</tr>
<tr>
<td>Autodesk Vault</td>
<td>data shortcuts, XML files</td>
</tr>
<tr>
<td>corridors</td>
<td>default template, specify</td>
</tr>
<tr>
<td></td>
<td>DEM export</td>
</tr>
<tr>
<td></td>
<td>Digging It</td>
</tr>
<tr>
<td></td>
<td>drag and drop styles</td>
</tr>
<tr>
<td></td>
<td>drawing</td>
</tr>
<tr>
<td></td>
<td>settings</td>
</tr>
<tr>
<td></td>
<td>structure, section views</td>
</tr>
<tr>
<td></td>
<td>templates</td>
</tr>
<tr>
<td></td>
<td>E</td>
</tr>
<tr>
<td>editing</td>
<td>feature line labels</td>
</tr>
<tr>
<td>survey tips 48</td>
<td></td>
</tr>
<tr>
<td>boundary for surface  81</td>
<td></td>
</tr>
<tr>
<td>boundary representation (grading) 139</td>
<td></td>
</tr>
<tr>
<td>breaklines, adding  84</td>
<td></td>
</tr>
</tbody>
</table>
feature lines 133
elevation points 131
eTransmit and project files 68
explode grading object 147
external references, using in project management 63

F

FACETDEV 178
FACETMAX 178
feature line grading 129
offset 146
folder permissions 65
footprint preparation 144

G

grading best practices 129
boundary representation 139
detached surface 146
example 147
feature line method 129
footprint preparation 144
infill 146
intersection of planes 140
object parts 137
offset feature lines 146
slope projection method 129
use of explode 147
grading group surfaces 146
grid surface 86
GRIPOBJLIMIT setting 27

H

HIGHLIGHT setting 28

I

infill grading example 152
ISAVEPERCENT setting 28

L

label styles editing 17
minimal 6
labeling xrefs 20
labels
profile high/low points 19
surface cut and fill 18
LandXML files 85
layers
deleting unused 14
for display management 7
lot lines
and grading 130
interaction with feature lines 131

M

Manning’s equation 193
mask for surface 80
memory optimizing 30
virtual 30

O

object styles minimal 6
offset feature lines 146

P

parcel creation automatic 105
from AutoCAD geometry 101
semi-automatic 106
parcels
best practices 101
editing 115
labeling 117
labeling xrefs 122
offsetting 117
site topology 103
spanning labels 125
table creation 128
  tag renumbering 127
parts catalog management 169
performance optimization 24
pipe networks
  best practices 167
design 175
display flow capacity 193
displaying in section views 178
labeling 182, 184
locating parts 180
Manning’s equation 193
multiple surfaces 180
parts catalog 167
parts lists 174
renaming parts 175, 181
resizing parts 174
smoothness in section view 178
user-defined optional properties 172
plan production tools
  best practices 34
point files
  and surfaces 84
  filtering 84
points
  elevation 131
profile high/low point labeling 19
profiles, for corridors 97
project management
  best practices 49
data referencing 51
eTransmit 68
external references, advantages and limitations 63
links between drawings 51
project import and export 68
project templates 66
user permissions 65
using Autodesk Vault 69
working folder 67
project structure, three levels 51
project template 66, 76
PROXYGRAPHICS setting 28
purging redundant data 31

Q
  QNEW command 4

R
  RAM increase 30
  REGENMODE setting 29
  right-of-way parcels 103, 117

S
  Sample_Styles drawing 9
  SAVETIME setting 28
  section swath width 98
  section view drawing structure 31
  simplify surface 80
  site object interactions 91, 130
  sites
    parcel interactions 103
  slope projection grading 129
  storm sewers data
    import 184
  styles
    drag and drop 13
    for sketches, concept drawings 16
    setting default 15
    surface transparency 17
  surface
    cut and fill labels 18
    snapshot 79
  surfaces
    contour data 87
    export DEM 86
    LandXML import 85
    masks and boundaries 80
    minimizing flat areas 88
  survey
    best practices 37, 48
  system settings for better performance 24

T
  table tag renumbering 127
template settings 28

V

Vault
  advantages 59
  best practices 60
  limitations 60
Vault references 58
VIEWRES setting 29

W

WBlock, removing corrupt data 33
working folder location 67

X

XML data shortcut files 61
xref labeling 20
xrefs. See external references